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About Distinct IntelliTerm
Distinct IntelliTerm provides a truly integrated solution to IBM and DEC terminal
emulation. From a single interface users can open up terminal sessions to all the different
machines on their network. Distinct IntelliTerm operates over the Telnet protocol
providing multiple session support to different hosts or gateways (up to 26 concurrent
sessions). It includes Distinct TN3270E and TN5250 emulation for IBM mainframes and
AS/400 hosts, with support for 3179G vector graphics and 3279 S3G. It also includes
VT52 through VT420 emulation, for connectivity to hosts such as UNIX or VMS. Below,
we outline some of the major features of these different terminal emulation modes.
TN3270E mode includes support for model 2,3,4 or 5 terminal emulation, extended data
streams, 3179G and 3279S3G graphics support, IND$FILE file transfer, definable
hotspots, definable keyboard and macros, scripting language fully compatible with Visual
Basic for Application(VBA), and drag and drop capabilities for easy text editing.
TN5250 mode includes support for model 2 (24 lines by 80 columns) and model 7 (27
lines by 132 columns). In general, most of the features available in the 3270 emulator are
also available in the 5250 emulator.
VT mode provides VT52, VT100, VT220, VT320 and VT420 emulation with many
additional features such as unlimited scrollback with search capabilities, ANSI support for
color extensions, definable hotspots, definable keyboard and macros, VBA advanced
scripting language, OLE Automation Server, DDE and much more.
Distinct IntelliTerm comes with a powerful set of tools for desktop application
development that include DDE, EHLLAPI, HLLAPI, WinHLLAPI, a full-featured
scripting language compatible with Visual Basic for Applications (VBA) and a Visual Basic
Toolkit.
Distinct IntelliTerm is available for all Windows platforms. Being a fully integrated
package, many features are shared by all emulators. Other features are specific to a
particular type of emulation, and therefore will not be seen in emulation sessions of a
different type.
Distinct IntelliTerm requires you to have preconfigured TCP/IP on your system.

About the Distinct Product Line
Distinct was the first company to produce TCP/IP products for the Windows market back
in 1989. Today, Distinct boasts a wide range of products, for the Internet and the
Intranet, that are engineered with an eye to detail and which have grown with the ever
changing market needs.
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About This Guide
This Guide takes you through all of the IntelliTerm features discussing all of the
emulator types. It specifies when a particular feature is only available for a
particular terminal type.
It aims at helping you set up a work environment that is customized to your needs
while acting as a general reference for specific features.
Chapter 1 describes how to install, start, open sessions in, and exit IntelliTerm. It
also gives useful information on some basic environment options such as using the
mouse and the toolbar. We suggest that all users read this chapter.
Chapter 2 discusses Distinct IntelliTerm Sessions and the IntelliTerm environment
options that can be customized. This chapter is intended for use as a reference. It
also describes emulator specific features such as Entry Assist.
Chapter 3 is a reference for doing file transfer in 3270 mode.
Chapter 4 provides all the information you need to customize your keyboard for
your emulation requirements and touches on the use of Quick-Keys that will help
you speed up your work when working with Distinct IntelliTerm. This
information is useful to all users.
Chapter 6 deals with information that may be useful when operating in host
graphics modes.
Chapter 7 describes how to configure and use Distinct FTP
Chapter 8 describes how to configure and maintain Distinct LPD.
Chapter 9 describes the Distinct LPR application.
Appendices A and B deal with the programming environment that comes with
Distinct IntelliTerm. They are intended for use only by the expert user and/or
engineer.

Conventions Used in This Guide
This manual uses the following formatting conventions to provide an overall,
consistent layout.
Conventions

Used for

bold

Menu selections, buttons, etc. used within steps or
when discussing actions.

italics

Variables, emphasis, or clarity.
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Conventions

Used for

ALL CAPS

Filenames, directories, or pathnames within
discussion paragraphs.

small Sans Serif

On screen examples or filenames, directories, and
pathnames as separate paragraphs within steps.

/
+

This icon indicates a NOTE or item of interest.
This icon indicates a WARNING. Please read all
such paragraphs.
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1
Getting Started

This chapter is intended to get you started using Distinct IntelliTerm. It
provides the basic information required to start a 3270, 5250 or VT
terminal session. It also describes your basic work environment and shows
you how to customize your toolbar.

Distinct IntelliTerm

How to Install Distinct IntelliTerm
Distinct IntelliTerm may either be installed on your LAN server for shared use or
as a personalized copy on your local system. The following describes what needs to
be done to install either of these two ways.

How to Install Distinct IntelliTerm on the LAN Server
To install Distinct IntelliTerm on the LAN Server for shared use, insert the CD
and choose the Install IntelliTerm for Shared Use option. Then follow the
on-screen instructions. A server installation will also install the file that each client
must run to configure the client for shared use and to create the necessary shortcuts
on the client machine. Administrators who are responsible for the server
installation must:
• Share the directory where IntelliTerm is installed as a read only directory.
•

Run the Distinct Floating License Manager if floating licenses are in use.

•

Inform all potential users that they need to map the network drive where
IntelliTerm files are installed on the server to a local drive.

•

Inform all potential users that they need to run the file INTEN32C.EXE to be
found in the same directory where the IntelliTerm files were installed on the
server.

How to Configure your System to Use a Shared Copy of
Distinct IntelliTerm
If your administrator has set up a LAN server to use a shared copy of Distinct
IntelliTerm, you must first configure you system to use it. To do this map the
network drive that contains the IntelliTerm files to a local drive, then run the
INTEN32C.EXE file from the server or from the Distinct IntelliTerm CD. This
will install the configuration file on your system as well as the necessary shortcuts.

+

If you are using a Floating License system and your Floating
License Server is not on your local subnet, you must specify host
name or IP address of your floating license server after choosing
Floating License in the License Manager dialog box.

How to Install your Personal Copy of Distinct IntelliTerm
To install your personal copy of Distinct IntelliTerm, insert the CD in the CD
drive and select the Install a Personal Copy of Distinct IntelliTerm installation
option. Then follow the on-screen instructions.
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Starting Distinct IntelliTerm
To use Distinct IntelliTerm, you must create a session and then a profile for your
session preferences.
To start Distinct IntelliTerm:
1 Double-click the Distinct IntelliTerm icon.

2

In the IP Host/Gateway text box, enter the IP host name or the IP address in
decimal dotted format, (such as ITX.Distinct.com or 132.206.41.0). Do not
enclose the name or address with quotes.

3

Select the Terminal Type and the Model you want. The terminal model selects
what features are installed in a particular terminal mode.

4

If the system to which you are trying to connect is attached to the Telnet
daemon using a port number other than the one displayed, change the TCP
Port to the port number in use. 23 is the default telnet port for most systems.
If you get the error message, unable to locate IP host/gateway, ask your system
administrator for the correct port number.

5

Select the Connect button to open the terminal session.
The resolved IP address will appear in the bottom center of the terminal
window. If your session is a 3270 session, the logo of your host system should
now appear in the main window. For more information on sessions, see
Chapter 2.

/

Administrators can disable the address from appearing within
the Operator Information Area. In the online help search for
“INI configuration parameters ” and look for the flag.
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Creating a Profile
After you open your first terminal session, you can create a reusable profile with
your preferences. This is very simple and can be done as follows:
1 Size the IntelliTerm window to the desired size on your desktop. Distinct
IntelliTerm uses True Type fonts for display and can resize itself to almost any
size. However, if you are operating with display resolutions from VGA
(640x480) to SVGA (1024x768), you can use the crisp internal font called
TCP Terminal.
2

Select the Edit Session Profile option from the Options menu. Click on a
category item to view the options available in that category. Check the boxes
or select the radio buttons for the options you wish to activate. You can move
from category to category making the required modifications.

3

To save the options, press the Save button. Change the profile name from
Default to any name of your choice. (The name Default has certain restrictions
and features, therefore, do not use this name until you read the “Profiles”
section later in this manual.)

Profile names may be up to 28 characters in length.
/
You can also save and create an icon for your session profile. To do so, select Save

Session Profile from the Options menu. You will be presented with the Save
Profile dialog box. Enter a name for your new profile in the text box displayed at
the top of the dialog box. Click the Create Shortcut for Profile checkbox, then click
Save.
For more information on profiles, see “Profiles” in Chapter 2.

Creating a Profile for EHLLAPI
If you plan to use EHLLAPI with Distinct IntelliTerm, you must first create one
or more profiles as described above. EHLLAPI short names are associated with
profiles. Short names allow EHLLAPI to know which host to connect to. You
need a different profile for each EHLLAPI session you plan to use. Once you have
created the profiles, set a short name for the profile(s) with the following steps:
1 Select the Save Session Profile option from the Options menu. The Save
Session Profile dialog box appears allowing you to assign a profile to an
EHLLAPI short name.
2

Select the short name letter you wish to assign from the HLLAPI Short Name
list and the profile to be assigned from the Profiles list.

3

Click on the Create Shortcut for Profile checkbox.

4

To save your settings, click on the Save button.

For more information on EHLLAPI, refer to Appendix A.
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Exiting Distinct IntelliTerm
You may immediately close a VT session and exit Distinct IntelliTerm by selecting
Close from the Control-menu box in the upper left hand corner of the window.
To close a TN3270 or TN5250 session, press Ctrl-B or select Close Session from
the File menu to do this. You will be prompted to confirm the end of the terminal
session. In both cases, if you only have one terminal session active, Distinct
IntelliTerm will be closed.
To exit Distinct IntelliTerm from a 3270 or 5250 session, and close all terminal
windows, press Ctrl-Q.
Upon disconnect, you have the option of closing the session window, keeping the
session window open, restarting the session, or showing the Open New Session
dialog box. Unless you specify otherwise, Distinct IntelliTerm automatically closes
a window when the connection to the host system is broken or terminated by the
host system.
If you try to exit Windows before closing all terminal sessions, Distinct IntelliTerm
will warn you and require that you close all terminal sessions first. This prevents
any problems with your system. However, you can override this option in the
ITERM.INI configuration file. See the section “Special Profile Options” in
Chapter 2 for more information.

On-line Help
Distinct IntelliTerm provides context sensitive help from all dialog boxes by
pressing F1 or clicking on the Help button. While in the main terminal window,
you can get help by selecting the Help menu option.

Command Line Options
There are some command line options that can be used to help you automate
certain tasks such as starting a single connection to a specified host or loading a
specified profile. Options are added to the program properties for the Distinct
IntelliTerm icon on your desktop.
If you are running Windows 3.x you modify this using the Program Item dialog
box which is displayed by choosing Properties in the Program Manager’s File
Menu.
These options are set by first creating a shortcut and then accessing the settings by
right-clicking the shortcut in the Windows Explorer. The commands should be
entered after the program name in the target text box.
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Program options are added to the end of the command line. Each option must be
separated by a space. Option letters may be in lower or upper case since the system
is not case sensitive.
The following table lists the available command line options:

Available Options

Function

-!

This option disables the requirement of running
Windows in the Enhanced Mode and changes to the
Windows Standard Mode. (Windows version only)

-C

This option enables a debugging mode where some
network tracing messages are written to the file
ITERM.TRC. The file will be in the current working
directory. This option is usually accompanied by the -D
option.

-D

This option enables dumping of inbound and
outbound data when tracing is enabled via the -C
option.

-H hostname [,Port]

This option overrides the gateway name or host address
when opening a session with a specific profile using the
-P option. The -H option is ignored when the -P
option is not specified.
If you specify a profile using the -P option, then the IP
address and port used with the -H option override the
profile values. If no profile name is specified, then the
profile name DEFAULT is used to open the session.
Use the -H option when you want to initiate
connections from other applications such as Gopher. A
sample command line syntax is shown below. The %i
must be replaced with the destination IP name or
address by your application.
ITERM32.EXE -H %i

-I

This option instructs Distinct IntelliTerm not to start
any profiles saved with the Auto Start option. This is
useful to start the emulator in interactive mode.
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Available Options

Function

-P profname [profname]
...

This option starts one or more sessions using the
profile(s) specified. This option ignores the Auto
Connect option and starts only the profiles specified.
This is very useful if you want to create icons that
connect to specific hosts. If you create an icon in the
Startup group to automatically start a session to a host
when Windows is loaded, make sure that you only
install one icon. If you want to auto start more than
one profile, list the multiple profiles on one command
line. Do not install multiple icons. Example:
ITERM32.EXE -P VMCMS TSO CICS

-U

This option can be used to close all hidden windows
and unload the emulator currently loaded in memory.
This option is only useful to shut down the emulator
after creating hidden connections through EHLLAPI.
Specify this option alone.

-V

This option is used to force the default session to VT
mode. This is useful if you are spawning the program
from another program and want to create a VT session
regardless of the setting of the [Default] profile.

-3

This option is used to force the default session to 3270
mode. This is useful if you are spawning the program
from another program and want to create a 3270
session regardless of the setting of the [Default] profile.

-5

This option is used to force the default session to 5250
mode. This is useful if you are spawning the program
from another program and want to create a 5250
session regardless of the setting of the [Default] profile.
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The Distinct IntelliTerm Environment
Distinct IntelliTerm provides a convenient environment to operate in, including a
toolbar, profile listbox, status bar, mouse options, and much more. To get you
started quickly, this section only discusses the most apparent environment features.
To learn about other features such as keyboard remapping, hotspots, and
poppads—to name just a few—see the appropriate sections in this manual.

Toolbar
The top section of the IntelliTerm screen is reserved for the Toolbar and is divided
into three ‘bands’. Each band holds either the menu bar, Toolbar or the Profile
Listbox. The Toolbar allows you to quickly perform actions using the mouse. The
Profile Listbox allows you to start a new session by selecting a profile from the list.
Distinct IntelliTerm allows you to change the display of the toolbar bands. You
can drag bands up, down, left, or right. The position of the bands will be saved
automatically when you exit your session.
To enable or disable the toolbar and profile listbox, select the Show Toolbar or
Hide Toolbar from the View menu.
The default toolbar loaded with Distinct IntelliTerm includes these buttons:
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Open a new terminal session

Terminate an existing terminal
session

Save current screen to disk

Cut selected text to clipboard
(TN3270, TN5250 only)

Copy selected text to clipboard

Paste text from clipboard to
cursor location

Select session font and font size

Choose next larger font

Choose next smaller font

Print current screen to printer

Getting Started
Upload a file to the host
(TN3270, TN5250 only)

Download a file to the PC
(TN3270, TN5250 only)
Change session options
(Preferences)

Press PA1 key
(TN3270 only)

Press PA2 key
(TN3270 only)

Press PA3 key
(TN3270 only)

Press Enter key
(TN3270, TN5250 only)

Press the PF1 key
(VT Terminal)

Press the PF2 key
(VT Terminal)

Press the PF3 key
(VT Terminal)

Press the PF4 key
(VT Terminal)

Field Plus
(TN5250 only)

Field Minus
(TN5250 only)

Field Exit
(TN5250 only)

Provides context sensitive help

Clear the Display

Toggle scroolback mode
(VT Terminal)

Emulates the “Del” key on the
VT keyboard

Modifying the Toolbar
The toolbar is a session resource, which means that you can have different toolbars
for each terminal session. To configure the toolbar, select Edit Session Profile from
the Options menu. Then select the Toolbar category from the Session Profile
dialog box. The Toolbar category displays the Toolbar Options.
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In the Toolbar category, you can add, change, or clear toolbar entries. Notice that
spaces separate sections of the default toolbar. These are entries where buttons may
be inserted. In the Tool to Change list box, they appear as [Space].

Changing a Tool
To change a tool, first select the tool from the Tool to Change list box that you
wish to change. Then you can select a new icon and/or a new function. To assign a
new icon, select the icon in the Button list box and then select the Change button.
To assign a new function, select a Function and select the Change button.
You can remove a tool from the toolbar by pressing the [Space] button. This will
create an opening in the toolbar (shown in your Toolbar as a space between the
buttons).

Resetting a Tool
To reset a tool to its default, first select the tool to be modified. Then select the
Reset Tool button. To reset the entire toolbar to its default values, select the Reset
All button.

Profile List box
The Distinct IntelliTerm Profiles List box performs various functions. At a glance
the user can see the current emulation mode, the name of the currently loaded
profile, and the IP address of the system currently connected. When you pull down
the Profile List box, you can view a list of session profiles that have been created
and saved by Distinct IntelliTerm. To open a new session with any of these
1-10
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session profiles, just select the profile from the list. The Profile List box reduces the
number of steps required to open a session profile.
The first time you run IntelliTerm, the list box will be empty as you have not yet
created any profiles. To add or delete a profile from the listbox, use the Save
Profile command in the Options menu.

Using the Mouse in 3270 or 5250 mode
Although the mouse is not required with 3270 or 5250 mode, it is a very
important tool to facilitate many day-to-day functions. For example, clicking the
left mouse button anywhere on the 3270 screen will move the cursor to that
location.
To learn the basic editing procedures, follow the steps below:
1 To move text, pressing the left mouse button, select the text and drag the
pointer to the new location where you want to move the block of text. The
pointer location will be at the upper left hand corner of the block of text.
When you release the left mouse button, the text will be moved to the new
location. (The previous text is only deleted if the fields containing the data
were unprotected.)
2

To copy a block of text using the mouse, first select the text. Then press the
Ctrl key and the left mouse button and drag the text where you want it
inserted. Make sure that you release the mouse button before releasing the Ctrl
key or the copy will not work properly.

3

To cut the text to the clipboard, select the text and press Ctrl-X. The program
will only delete the text on the screen if it appears in unprotected fields. To
copy the text to the clipboard, select the text and press Ctrl-C. Once in the
clipboard, you can move the cursor to the specified location on the screen and
press Ctrl-V to paste the text in the clipboard back to the screen.

To copy the entire 3270 or 5250 screen to the clipboard, first press
Ctrl+Numpad 5. (Numpad 5 is the 5 key in the keypad area. The NumLock
must be off for this combination.) Then press Ctrl-C to copy the screen to the
clipboard. Again, once in the clipboard, you can move the cursor to any
location on the screen and press Ctrl-V to paste the text in the clipboard back
to the screen.
You can select the highlighting method in the Session Profile dialog box. It can be
a reverse highlight block or a rubber-band style selector box.
4
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Default Mouse Actions - 3270 mode
The default mouse actions are configured as follows:

Do this

To

Click left button

Move the cursor to the pointer location.

Click right button

Move the cursor to the pointer location
and press the Enter key. This is very
useful for 3270 applications that use
pull down menus such as Rice MAIL.

Click and drag left button

Highlight a block of text to delete,
move, or copy to another location on
the screen or the clipboard.

Double-click left button

Activate the hotspot feature. If the text
at the pointer location corresponds to
any hotspot text, the hotspot action will
be performed.

Shift+click left button

Perform the 3270 or 5250 Clear key
action.

Shift+click right button

Perform the 3270 or 5250 Enter key
action.

Ctrl+click left button

Perform the 3270 PA1 key action.
(3270 mode only)

Ctrl+click right button

Perform the 3270 PA2 key action.
(3270 mode only)

Shift+Ctrl+click left button

Display the Track Menu. (3270 mode
only)

Shift+Ctrl+click right button

Display the Track Menu. (3270 mode
only)

Light Pen Emulation
Distinct IntelliTerm supports Light Pen emulation using the mouse. If you wish to
set the right mouse button, set it to Move-Cursor-Cursor-Select. This function
moves the 3270 cursor to the current mouse pointer location and presses the
Cursor Select function which emulates the light pen.

Using the Mouse in VT Mode
In VT mode the mouse can be used to simplify the cutting and pasting operations.
The left mouse button is used to select a block for copying text to the clipboard. In
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VT mode, you should enable the Auto Copy Selected Text feature which is located
in the Cursor Category of the Session Profile. With this enabled, the system
automatically copies a highlighted block to the clipboard and then removes the
selection.
The right mouse button is assigned to the Paste function. Therefore, if there is
anything in the clipboard, clicking the right mouse button will paste the text to the
host system.

Default Mouse Actions - VT Mode
The mouse actions are configured as follows by default:

Do this

To

Click left button

No action. To change this to copy, enable
Auto Copy Selected Text as described in the
paragraph above.

Click right button

Paste text in the clipboard to the screen. If the
clipboard is empty, no other action is
performed.

Click and drag left button

Highlight a block of text to copy to the
clipboard.

Double-click left button

Activate hotspot feature. If the text at the
pointer location corresponds to any hotspot
text, the hotspot action will be performed.

Shift + click left button

Clear the current screen.

Shift + click right button

Clear the entire device buffer.

Ctrl + click left button

Press the VT420 Find key.

Ctrl + click right button

Press the VT420 Insert Here key.

Shift + Ctrl + click left button

Bring up Track Menu.

Shift + Ctrl + click right button

Bring up Track Menu.

Changing the Mouse Action
To change the mouse actions:
1

Choose the Edit Session Profile option from the Options menu. Then choose
the Mouse category.
Here you can change all mouse features except for the left Mouse Button
which is reserved for pointing to and selecting text.
The Mouse category appears as follows:
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2

Select the mouse button combination that you wish to change from the Mouse
Options list box.

3

Select one of the mouse functions in the Functions list box.

4

Click on the Set button to set the association.

5

When you have completed your changes, select OK to accept the changes or
Save to save the options permanently to a profile.

Operator Information Area
The 25th line of the display is dedicated as the Operator Information Area, or
OIA. The OIA displays information about the status of the current session.

The most common indicators that display in the OIA are the following:

OIA indicator

Means

X Clock

Keyboard Locked. The keyboard is locked since an
attention (AID) generating key was pressed.
(3270/5250 mode only)
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OIA indicator

Means

X SYSTEM

Keyboard Locked. This OIA indicator warns that the
3270 keyboard is locked. The Reset key must be
pressed before any other 3270 operation can take
place. (3270/5250 mode only)

^

Insert Mode. This indicator shows that the Insert
Mode is toggled on. The Insert mode can be reset by
pressing: the Insert key again, the Reset key, or any
AID generating keys. (AID or attention generating
keys are: Enter, PA1, PA2, PA3, Clear, and PF1 to
PF24.)

X Num

Keyboard Locked. You attempted to enter a
non-numeric character in a numeric field. (3270/5250
mode only)

X <-‡->

Keyboard Locked. Go elsewhere. You cannot enter
data at current location. Move the cursor to an
unprotected field. (3270/5250 mode only)

Sess-1

Session Name. Column 20 in the OIA is the session
long name. This is an eight character name identifying
which session you are currently viewing. This string
can be changed by renaming the Session Long Name
in the Hosts Category of Session Profile. The default
value of this is from “Sess-1" to ”Sess-5".

DOC

Entry Assist enabled. This indicator shows that the
3270 Entry Assist feature is enabled. (3270/5250
mode only)

>>

Word Wrap enabled. These characters (>>) display
next to DOC and only if the 3270 Entry Assist feature
is enabled. (3270/5250 mode only)

A

Session Short Name. Column 19 contains the session
short name assigned. If the value is numeric, then the
EHLLAPI Short Name was not assigned to the profile
name.

PROGxxx

A severe error has occurred in the 3270 data stream
Consult the IBM 3270 manual or 3x74 manual for a
description of error codes (e.g. PROG505 means that
the host is unavailable). (3270 mode only)

132.206.41.1

This is the IP address of the host to which the session
is connected. This address appears in column 31 in the
OIA.
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OIA indicator

Means

#

Numeric Field. Column 72 contains a pound sign if
the field at the cursor location is a numeric field.
(3270/5250 mode only)

§

Operator Selectable Field. Column 73 contains this
character if the field at cursor location is operator
selectable. (3270 mode only)

rr/cc

Cursor Location. If Entry Assist is enabled, cursor
position
is displayed in row and column values (starting at 1/1).
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This chapter explains how Distinct IntelliTerm sessions are created. It
explains how to save a session, with all its settings, as a profile that can be
used in future sessions. It also describes how you can customize your session
environment by creating custom poppads and associating these with specific
profiles. The use of hotspots as a time saving device in your work sessions is
also explained. This chapter includes other information related to enhancing
your IntelliTerm sessions.

Distinct IntelliTerm

Opening Sessions
Distinct IntelliTerm will open one session for you when you connect to your host.
You can open up to 26 concurrent sessions. Each session can be of any terminal
type. For example, you can have 2 TN3270 sessions and 3 VT sessions and 4
TN5250 sessions.
To open a new session:
1 Press Ctrl-A from any 3270 or 5250 window, or select Open Session from the
File Menu to open a VT session. You may also open a session by clicking on
the open session button in the toolbar. The Open New Session dialog box
appears. (The default gateway name to which you may connect is highlighted
in the IP Host/Gateway text box.)
2

If you have previously saved profiles, you can open a session by selecting the
profile name from the Profiles list box.

3

To open a session without using an existing profile, enter the name of the host
or IP address in decimal format of the host to which you wish to connect
(such as VXT.Distinct.com or 132.206.41.1) in the IP Host/Gateway text box.

4

Click Config if you want to edit an existing profile or create a new one before
you start your session.

/
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If you reach the maximum number of sessions, attempting to
open a new session will display a message indicating that the
maximum number of sessions has been reached.
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5

Set the correct session parameters such as terminal type or model and the TCP
port if needed.

6

Press the Connect button to open the session. If the connection is successful, a
new terminal window will appear. Notice that the session name has also
changed. If a connection was not possible, an error message is displayed.

Closing Sessions
You should first log out or exit your host operating system to make sure that your
session is properly terminated. To close a session, press Ctrl-B from any active
3270 or 5250 window or select Close Session from the File menu; unless you are
disconnected from the host, Distinct IntelliTerm will prompt you to confirm the
termination of that session.

When a session is closed, the window will move to the next active session if there is
one. If no other sessions are active, the program will terminate and you will return
to the Program Manager or your desktop viewer.

Changing Sessions
You can switch windows by using the Window menu option and then selecting the
session name you wish to switch to. You can also press Ctrl-N to access the next
session if you are in a 3270 or 5250 session.

Saving Time with Host Searching
If you are working in a situation with multiple hosts that contain mirror
information and have login access to several of these hosts, host searching can save
you a lot of time by allowing you to connect to your system fast. The use of this
option avoids you having to manually try to open sessions making your own guess
as to which systems are less busy, it immediately connects you to the first available
system. An example of where this feature would come in handy is accessing credit
card data bases.

Session Errors
If the network link terminates abnormally, a message box will indicate that a
network error has occurred and that the session has been terminated. If you have
more than one session active, Distinct IntelliTerm will display the name of the
session that was terminated. The error window will stay active until you press
escape (Esc). Abnormal termination may be due to problems with the network, or
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may occur because the remote host is no longer available. When this happens, you
must reopen your sessions manually by selecting Open Session .... from the File
menu.
If the session that was terminated was the only terminal window, then the Distinct
IntelliTerm program will close.
If the terminal session is a 3270 or 5250, then a “PROG505” will appear in the
Operator Information Area when the host system or host server is unavailable.
Your session will be restarted automatically when the system comes back up. In
this situation, the link to the gateway is still active and the gateway can request the
host to restart a session.
To reopen a session to the same host, select Open Session .... from the File menu.
The IP address for the host should appear in the dialog box. Press Connect to
reconnect.

Session Options
Distinct IntelliTerm allows you to set each option independently for each terminal
session. This lets you customize each session and save the options to a profile.
Categories that apply to the terminal type (3270, 5250, VT) will appear in the
category listbox.
To change options for all sessions make the appropriate option changes and save
them as the [DEFAULT] profile. To change the session options, select Session
Profile from the Options menu. The Session Profile dialog box will appear.
The Category list box allows you to choose which category of options you wish to
change. When you select a new category, the dialog box options will change to
reflect options for this category.
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Use the mouse or keyboard to toggle or change any of the options in the category.
Each option is described below.

Common Categories
The following categories are common to all terminal types (3270, VT, and 5250):
Colors Category
This dialog allows you to change the field colors. See the section “Session Colors”
later in this chapter.
Color Palette Category
This dialog allows you to modify the color combinations used to create the base 16
colors used by the program. See the section “Customizing Colors” later in this
chapter for more information.
Cursor Category
This dialog allows you to tailor the cursor options.
Cursor Type

This option sets the cursor type, either a block,
underscore, or vertical bar.

Cursor Mode

This option sets the cursor mode. It can be either
solid or blinking. Blinking is the default.
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Mouse Select Mode

This option sets the highlighting mode used when
you select a block of text with the mouse. It can be
either a reverse highlight or a rubber-band mode.

Auto Copy Selected Text

This option enables the system to automatically copy
the highlighted text to the clipboard and remove the
selection frame once you finish highlighting a block
of text. This option is
particularly useful in VT
terminal mode. Combined with the Paste assigned to
the right mouse button, this allows easy copy and
paste operations. You may additionally select to have
the copy selection saved in RTF (Rich Text Format)
and/or as a bitmap.

Font Category
This dialog allows you to tailor the Font parameters. See the section “Working
with Fonts” later in this chapter for more information.
General Category
This dialog allows you to tailor the general session options.
Sound

This option enables or disables all sounds produced
by the emulator.

Notify

When enabled, this option causes a beep to sound
when a session which is not the active window is
updated by the host system.

Type Ahead

This option enables the Type Ahead feature. Type
Ahead allows you to keep typing after an Attention
generating key is pressed. All keys are stored in the
type ahead buffer and the keys are processed when
the host system unlocks the keyboard. The type
ahead buffer can be cleared by pressing the
Reset-Type-Ahead key (default is Ctrl-H). This
option appears only in 3270 and 5250 modes.
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Start Profile Automatically

This option is used to start the profile automatically
when the emulator is started with no command line
options. Note that if you enable this feature, and
you configure the emulator to automatically close
the session window upon disconnect from the host,
and you cannot connect to the specified host, it will
be impossible to start IntelliTerm to activate
another profile. Under these extreme
circumstances you must manually edit the
ITERM.INI file to turn this feature off. To do
this, search for “Auto Connect=On” under the
profile you specified as your autostart profile and
delete it.

Save Profile on Window
Close

This option causes the program to save the current
settings to the session profile automatically when
the session window is closed.

Upon Disconnect from Host This option enables you to choose the action taken
by the emulator when the session is terminated by
the host system. When you logoff a host, the telnet
session is normally closed. This option allows the
emulator to detect this and perform the action you
have specified. This makes Distinct IntelliTerm
work like a real
local-attached terminal.
Auto Start Quick-Key

The Quick-Key name entered here is automatically
executed when a new session is created. This allows
you to automate certain login operations. To view
the list of existing Quick-Keys, press the down
arrow button located at the right edge of the edit
field. You can also enter an external Macro name.
To force the system to execute an external macro,
make sure the name contains any directory
character such as a period, backslash, or colon.
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Search for Available Hosts

Upon receiving data from
host run this macro

This option enables IntelliTerm to automatically
start and close profiles until a login prompt is
presented to the user. The search order must be
configured by the user before this feature will
work. To configure a search order, click the Search
Pref button. See also Saving Time with Host
Searching earlier in this chapter.
Allows you to automate the running of a specific
macro in response to any data coming from the
host. This option may be useful for some screen
scraping activities.

Host Category
This dialog allows you to tailor the host name and session name options.
IP Host/Gateway

This option sets the IP host name or address (for
the session profile).

Telnet Name Override

This option allows you to override the name used in
the telnet negotiation when connecting to a host
system. Usually, the name is in the form
“IBM-327x-y-E” where the ‘x’ is an 8 or 9 and the y
is the model type (2,3,4,5). The “-E” is appended
when Extended Attributes are enabled.

Session Long Name

This name (up to 8 characters) appears in the
Operator Information Area, in the window caption,
and as the session reference under the Window menu
option.

Session Password

This option allows you to enter a password which is
stored in an encrypted format on disk. The data
entered here can be accessed through the command
function called “Password”. This is normally used for
IBM systems.

TCP Port

This option allows you to change the default Telnet
Port number. The default port is 23.

Connect time out

This option specifies the amount of time in seconds
that the system will wait for a connection before
returning an error. If you connect to very busy
systems increasing this value should reduce your
connection failure rate.
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Keyboard Category
This dialog allows you to select the keyboard profile for this session. If no profile is
specified, then the default internal system profile is used.
Keyboard Profile

Select the keyboard profile which will be active for
this session and profile. To create a new keyboard
profile you need to select Keyboard Mapping from
Terminal Settings in the Options menu.

Mouse Category
This dialog allows you to tailor the mouse functionality. See the section “Using the
Mouse” in Chapter 1 for more information.
Print Category
This dialog allows you to tailor the printing options that are used with the Print
Screen and Print-Raw commands.
Add FormFeed After Raw
Print Screen

The functions Print-Raw and Print-Raw-LPTx are
used to perform ASCII print screens directly to the
printer port. This option sends a formfeed at the
end of the screen to eject the page. To disable this
feature, clear the checkbox.

Print Border

This option will print a thick black border when
you use the Print-Screen function.

Print Operator Information
Area

This option will print the Operator Information
Area (last line of the screen) when using the
Print-Screen or Print-Raw functions.

Print Screen Location

This option determines the location of the screen
print when using the Print-Screen function.

Toolbar Category
This dialog allows you to tailor the toolbar to icons and commands of your choice.
Tool to Change

This list box displays the currently defined buttons.
Select the button in the box that you wish to change.
Entries marked [space] are empty slots which can be
replaced by additional buttons. To leave all currently
defined buttons unchanged and add a new button at
the end of the toolbar, select the first or second
[space] following the Toggle-Scrollback button.

Button

This list box displays the list of available icons that
can be placed on the toolbar.
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Select Function Type

This option selects what commands will be displayed
in the list box below it. This allows you to view the
available functions in logical groups.

[Space]

This button changes the current entry to an unused
slot.

Change

This option changes the tool to the new button
and/or command.

Reset All

This option resets all the tools to their default system
values.

Reset Tool

This option resets the current tool to its default
value.

Windows Title Category
This dialog allows you to tailor the name for the current session window. The
options are created in the order they appear in the dialog box.
Short Name

This option adds the EHLLAPI short name to the
title.

Long Name

This option adds the Session Long Name, configured
in the Host Category, to the title.

Profile Name

This option adds the profile name to the title.

Dimensions

This option adds the terminal window dimensions to
the title.

Use Separator

This option instructs the program to use a hyphen as
the option separator.

3270/5250 Specific Categories
The following categories are visible only when configuring a 3270 or 5250 type
session.
3270 Model Options
This dialog allows you to change the 3270 or 5250 terminal type features. These
options are mainly used when the 3270 terminal is initially created.
3270 Type
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3270 Model

These radio buttons allow you to choose the 3270
model type. This determines the maximum size of
the 3270 screen.

Enable Extended Attributes This option allows you to disable the Extended
Attribute (EAB) support. This is useful if your host
system does not properly support EABs.
Send OEM Reply to RPQ

This option will disable the proprietary reply to a
Read Partition Query. If you have trouble loading
GDDM or SAS, disable this feature.

Force Alternate Size

Tells the emulator to automatically go to alternate
mode.

5250 Model Options
This dialog allows you to change the 5250 terminal type features. These options
are mainly used when the 5250 terminal is initially created.
5250 Model

Specifies the 5250 model for this terminal type. A
Model 2 is 24 lines by 80 columns, and a Model 5 is
27 lines by 132 columns.

Color Display

Enables the program to use 5250 color mapping for
field attributes. When disabled, the 5250 uses only
Green and White colors.

Column Separators

Enables you to choose the type of column separator
to be used by IntelliTerm.

Display Options (3270/5250)
This dialog allows you to tailor the display options.
Auto Keyboard Unlock

When enabled, this feature relieves you from ever
having to press the Reset key to unlock the
keyboard. This feature is available in 3270 mode
only.

Convert Nulls to Blanks

When enabled, in-stream nulls are converted to
blanks. This means that nulls in input fields that are
‘trapped’ between EBCDIC characters are converted
to spaces so the data on the screen stays in the
appropriate columns. This feature is more efficient
than using the ‘SET NULLS OFF’ feature on most
host editors. However, this feature does cause
problems in systems such as TSO where the field
attribute for the input area is actually on the previous
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line. The system ends up receiving some 50-80
blanks followed by the command text. Some
applications have trouble parsing such a long input
string. This feature is available in 3270 mode only.
3278 Style Insert

When enabled, this option causes the Insert key to
work as on a 3278 terminal. In 3278 mode, the
Insert Mode is not reset by pressing any AID (Enter,
PFxx,...) generating key. This feature is available in
3270 mode only.

Show Nulls

When enabled, this option displays null characters in
unprotected fields as centered dots. This option is
similar to the Word for Windows™ “Spaces” option.

Always Autoskip

When enabled, this option causes the system to
autotab to the next unprotected field when you reach
the end of an unprotected field. This feature is
available in 3270 mode only.

Multiline Delete Mode

This option causes the delete and backspace key to
delete characters until the end of the field as opposed
to the end of the current line. Real 3270/5250
terminals do not delete past the end of the line.

Multiline Insert Mode

This option causes Insert Mode to insert characters
until the end of the field as opposed to the end of the
current line. Real 3270/5250 terminals do not insert
past the end of the line.

Respect Numeric Fields

When enabled, this option prevents you from
entering text in numeric fields. You can only enter
numbers and special characters in numeric fields.
This feature is available in 3270 mode only.

Display Blink as Italic

Since it is rather hard for Windows to display
blinking text, this option allows you to map the
3270/5250 Blink attribute to an Italic font.

Show Hotspots

This option allows you to see where all the hotspot
fields are on the screen. When enabled, all hotspot
fields are drawn in black text on a gray background.

All Uppercase

This option forces all text to be displayed in upper
case.

Display Row/Col Indicator This options enables the display of the row and
column indicator for the cursor in the lower right
hand side of the OIA.
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Entry Assist Category
This dialog allows you to tailor the Entry Assist parameters. See the “Entry Assist”
section later in this chapter for more information.
File Transfer Category
This dialog allows you to tailor the file transfer options. The File Transfer category
is available in 3270 and 5250 modes only.
Host System

This option sets the default host operating system
type.

Initial Action

This drop-down list enables you to specify what
action is performed before a file transfer is initiated.
This is useful if you must clear the screen or move
the cursor before starting the file transfer. The
default is No Action.

Code Pages

This option sets the code pages for both the PC
and the host.

File Transfer Block Size

This option sets the file transfer block size. The size
can range from 512 bytes to 9999 bytes. On local
high speed networks, the larger the block size, the
faster the transfer speed.

File Transfer Program Name This option allows you to change the file transfer
program name. This is useful if you want to
perform some pre-processing with an exec before
actually starting the file transfer or if you need to
change the name because the ‘$’ is not part of your
host character set.
Clear Monitor Automatically This option clears the File Transfer Monitor
automatically at the end of a file transfer. When this
option is disabled, you must click on the OK
button to view the results of the file transfer.
PCPrint Category
This dialog allows you to tailor the printing options that are used with the
PCPRINT, TPRINT, and Raw print commands. The PCPrint category is available
in 3270 mode only.
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7171 Passthru Printing

Distinct IntelliTerm supports 7171 Transparent
datastreams to allow the host to print information
easily. When a transparent datastream is received,
the program searches for the Printer On/Printer
Off commands to control printing. This option
selects what sequence the program will search for,
either the VT100 or IBM 3164 sequence. Note:
TPRINT typically uses the VT100 sequence.

Send PCPRINT/TPRINT
Output to

You can control the destination of the PCPRINT
and TPRINT programs in this groupbox. You can
direct output to the Default Windows Printer or to
the Windows clipboard. If you select the Default
Windows Printer, you must have a valid printer
port selected in the Control Panel. The clipboard
option allows you to print a file and paste it directly
into the clipboard in CF_TEXT format. This is
useful if you want to paste a host file directly into
any Windows application.

Printer Initialization
String

This option is used to send a printer setup string at
the beginning of a PCPRINT or TPRINT job.
This sequence is sent when the Printer On
command is received in the data. The string can be
up to 255 characters and can contain escape
sequences. See the section “Escape Sequences” later
in this chapter for the reserved character
combinations.

Printer Deinitialization
String

This option is used to send a cleanup string to the
printer when a PCPRINT or TPRINT job
completes. This sequence is sent when the Printer
Off command is received in the data. See the
section titled “Escape Sequences” later in this
chapter for the reserved character combinations.

Save Category
This dialog allows you to tailor the options that affect saving screens to disk.
Save Mode

This option determines whether new saves will
append (default) to the end of the save file or
overwrite the save file.

Save As

This option controls the code page used to save a
screen image to disk. Select the ANSI (Windows)
code page if you intend to use the file with another
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Windows program. Select the ASCII (DOS) code
page if you plan to use the file with a DOS program.
Confirm All Saves

This option forces all save options (except for
Capture mode) to prompt you for the save
information.

Default Save Filename

Enter the path and name of the save file here.

Translate Tables Category
This dialog allows you to tailor the translate tables for this particular session. You
can override the global translate tables if you need different translations for each
session. See the section “Translate Tables” later in this chapter for more
information.

VT Specific Categories
The following categories are visible only when configuring a VT type session.
VT Model Options
This dialog allows you to select the VT terminal type and communication options
for the session.
Terminal Model

This option selects the VT terminal model for the
session. Since the emulator always operates in
superset mode, this option is mainly used to select
the appropriate sequences for the keyboard
commands.

Communication Mode

This option selects the communication mode with
the host. The default is 7-bit mode.

Answerback Message

You can enter the answerback message in this edit
box. You can use the special escape sequences
described later on in this chapter to send
non-printable characters.

Conceal

This option, when enabled, conceals the answerback
message. If this option is disabled, the answerback
message will be cleared automatically.

Character Sets
This dialog allows you to select the character set options for the session.
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UPS Set

You can select the User Preferred Supplemental
character set to be either the DEC Supplemental or
the ISO Latin-1 character set.

NRC Set

You can select the National Character Replacement
character set in the list box.

VT Display Options
This dialog allows you to select various display options for the session.
Display Blink as Italic

This option allows you to map the VT Blink
attribute to an Italic font.

Show Hotspots

This option allows you to see where all the hotspot
fields are on the screen. When enabled, all hotspot
fields are drawn in black text on a gray background.

Display Row/
Col Indicator

This option enables the display of the row and
column indicator for the cursor in the lower right
hand side of the OIA.

Compress Blank Lines in
Scrollback

When this option is enabled, the system does not
add blank lines to the scrollback buffer.

Show Scrollbar for
Scrollback

This option enables the system to display a vertical
scrollbar when you enable scrollback mode. This
allows you to travel easily through the scrollback
buffer.

Save Attributes in Scrollback This option enables the system to save all VT
attributes in the scrollback buffer. If disabled, the
system saves only the text. Note that when enabled,
this option consumes four times the amount of
memory for each line.
Lines Available in Scrollback This option controls the amount of lines that are
kept in the scrollback buffer. You can save up to
9999 lines in the scrollback buffer. The default
value is 100 lines.
The scrollbar is activated by clicking F4. However,
Scrollbar Always Active
if you select this option, the scrollbar will remain
active for the entire session.
Whenever the clear screen command is issued the
Preserve Scrollbar on clear
previous screen contents will be moved to the
screen
scrollback buffer.
This option enables the arrow keys on the keypad
Use UP/Down Arrow keys
to be used for scrolling through the scrollback
for scrollback
buffer.
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Status Line

This option controls whether the status line is
visible or not and whether the host system can
write to the status line. You can choose to inhibit
the use of the status line, have it populated by the
host or display the current status information.

Format
This dialog allows you to select the screen size for the session.
Default Screen Width

This option sets the default screen width when a
session is created.

Default Screen Height

This option sets the window size for the session. The
sizes are only available if the VT Buffer Size is set to
6 Pages.

VT Buffer Size

This option sets the internal display buffer size. If
you do not require any of the VT420 specific
features, then select 1 Page. This will conserve
memory and accelerate certain functions. This option
has no effect on the scrollback buffer size.

Keyboard Options
This dialog allows you to select various keyboard options for the session.
Send Enter Key as

This option determines determines whether a
carriage return or a carriage return and line feed are
sent when the Enter key is pressed.

Backspace

This option determines what character is sent when
the Backspace key is pressed.

Cursor Key Mode

This option determines what sequences are sent
when the cursor keys are pressed.

Keypad Key Mode

This option determines whether the numeric keypad
is used for numbers or whether it is used in
Application mode.

Preferences
This dialog allows you to change various VT system options.
Auto Wrap

This option enables the cursor to automatically wrap
at the end of a line when the line length is exceeded.
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Local Echo

This option will echo all data entered in the system.
This option is normally not enabled.

Terminal is Online

When this option is disabled, the terminal is offline
and cannot receive or send any data.

Control Codes

This option determines whether the system acts upon
or displays control codes that are received. The
Display Option is normally only used for debugging
purposes.

Scrolling Method

This option controls how the system scrolls by
default. Normal mode scrolls data line by line. This is
also referred as Jump scrolling. The Smooth option
causes the system to scroll data ‘n’ pixels at a time.
Smooth scrolling is much slower and requires a
better video display adapter.

Display Mode

This option determines how the system will display
incoming data. In Realistic mode, the system updates
the display after each byte or command received.
This accurately emulates a true terminal. However,
this mode is much slower due to the overhead
required. In Optimized mode, the system only
updates the display at the end of a communication
buffer. This mode often skips scrolling operations
and simply displays the final buffer. This provides a
lightening fast display.

VT Save Category
This dialog allows you to tailor the options that affect saving screens to disk.
Save Mode

This option determines whether new saves will
append (default) to the end of the save file or
overwrite the save file.

Capture Mode

This option determines how the system will capture
data to disk. In Text mode, the system captures all
lines terminated with LF, VT, or FF. In Raw mode,
the system captures all data received including
control and escape sequences.

Default Save Filename

Enter the path and name of the save file here.

Tabs
This dialog allows you to change the VT tab positions.
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Tab Stops

Enter the tab stops starting at column 1. Use the
Every 8’th button to set tab stops at every 8’th
column starting with column 9.

Escape Sequences
Escape and binary codes are entered via the well known ‘C’ style syntax using the
backslash character (‘\’). Inline spaces are treated as part of the sequence.
\a

Bell (alert)

\b

Backspace

\e

Escape

\f

Formfeed

\n

Newline

\r

Carriage Return

\t

Horizontal Tab

\v

Vertical Tab

\’

Single quotation mark

\"

Double quotation mark

\\

Backslash

\xhh

ASCII character in hexadecimal notation

The sequence \xhh allows you to specify any ASCII character as a hexadecimal
character code. For example, you can give the ASCII backspace character as the
normal C escape sequence (\b), or you can code it as \x08 hexadecimal.
You must use at least one digit for a hexadecimal escape sequence, but you can
omit the second digit. Therefore, you can specify the hexadecimal escape sequence
for the backspace as either \x8 or \x08.

Session Colors
As with the session options, you can tailor the 3270/5250 and VT colors to your
preference for any session. Since the color information is saved in the session
profile, you can set colors differently for each session.
To change the session colors, select the Color Category from the Session
Preferences dialog (Session... from the Options menu). The following dialog will
appear. The contents of the listbox will be different for each terminal type.
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To change a session color, first select the color name you wish to change. Then
click on the color block that you wish to assign. Select Foreground Color to
change the text color and select Background Color to change the background
color.

/

3270 Mode: If you are not sure what name to choose, use the
mouse and click on the color in the 3270 session and the
appropriate name will be automatically highlighted.
Reset Color
Resets a color back to its default values. Select the
color and then press the Reset Color button.
Reset All

Resets all colors back to their default values.

MonoChrome

Changes all color mappings for use on a
monochrome device such as a laptop.

Uniform Color

Sets the foreground or background color to a
uniform color. Select the color for any field and then
click on the “Uniform Color” check box.

When you have completed your changes, press OK or Save... to save the values for
the current session.
If you understand 3270/5250 field concepts and wish to have more control over
the 3270/5250 colors, press the Advanced button. The list of field color types will
be expanded. You will now have complete control over the terminal colors.

Customizing Colors
On systems equipped with 256 color capability (Super VGA, 8514, XGA, ATI,
etc.), you have the ability to change the color composition of the basic 16 colors.
The Colors category lets you assign any of the base 16 colors to a field. But in the
Color Palette category, you can change the composition which makes a base
system color.
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For example, the Dark Blue color is by default composed of 50% Blue, 0% Red,
0% Green; Light Blue is composed of 100% Blue, 0% Red, and 0% Green. To
make the Light Blue more appealing (example, IBM color 3270 devices such as a
3179G), you could set the Light Blue to 100% Blue, 0% Red, and 50% Green.
Since the customized colors are implemented through color palettes in Windows,
the changes made to the palette affect all 3270 terminal sessions. They do not
affect any other application running on your system.
1 To access the Color Palette, select the Color Palette category from the Session
Profile dialog box. The following will appear:

2

To change any base color, select the base color first (select the color block),
then move the scroll bars to the color composition that you wish. You will see
the sample text change as you move the scroll bars.

3

To reset a color back to the system default, select the color and then press the
Reset Color button.

4

To reset all colors back to the system defaults, press the Reset All button.

5

When you have completed your changes, press Save or OK. The Color Palette
changes are system-wide and are saved to a system-wide profile automatically.
You do not need to save the color palette changes to a profile to have them
take effect.

Profiles
Distinct IntelliTerm ships with a default profile. The default profile contains
default values for all the options available in all terminal types. If you use more
than one terminal type to access different systems or the same terminal type to
access different systems of the same type, we suggest that you create profiles for all
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the frequently accessed systems rather than modify the default profile. When
making changes to the default profile you need to remember that these changes
will be made to the default settings for all new profiles created. A session profile
includes all the changes you make to session options as well as to the keyboard
layout.

Creating and Saving a Profile
You should create a profile for each session that connects to a different host or
requires different session options. To create and save a profile:
1 Open a new session using the New Session Command in the File menu or by
clicking the New Session button in the toolbar. In the Open New Session
dialog box enter the IP address or host name you wish to associate with the
new profile, then click on the Config button.
2

Customize the session to your preferences. For example, size the IntelliTerm
window and select the options you want from any category available for the
terminal type you have selected.

3

To save a new profile, select the Save button. A dialog box appears.

4

To save the window position and font selection, check the Save Window
Layout in Profile button. Type a profile name that is descriptive of the job you
do when you access the system such as invoices. If you wish to create a
shortcut that will automatically make a connection to the system, check create
shortcut for Profile. If you need to call this profile from a EHLLAPI,
HLLAPI or WinHLLAPI application you need to assign a HLLAPI Short
Name to this profile. When you have made all the appropriate selections click
the Save button.

5

You are now ready to make any other modification you wish this profile to
have such as keyboard remapping and choice of fonts. When all the changes
are complete, select Save Session Profile from the Options menu to add the
new changes to your profile. Make sure that the profile name is currently
displayed in the text box before clicking Save.

Creating Program Icons
You can have Distinct IntelliTerm automatically create a program icon for a given
profile, with all the appropriate options. This icon allows you to directly connect to
the host with the specified profile.
To create a program icon, enter a profile name in Profile text box in the Save
Profile dialog box. Click the Create Shortcut for Profile checkbox then click Save.
This will immediately save the profile and display the following dialog box.
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Deleting a Profile
You can delete existing profiles from the Save Profile dialog box. To delete an
existing profile, select Save Session Profile from the Options menu and select the
profile with the mouse. The profile name will be copied to the edit box. Then
select the Delete button to delete the profile.

Special Profile Options
There are a number of system tuning parameters which you can manually insert in
the ITERM.INI file in the Windows directory. These parameters allow certain
default characteristics to be modified.

System Wide Changes
System wide changes can be made by adding or changing an entry in the
[System.Settings] section of the ITERM.INI file. The parameters that can be
changed are listed below:
Display Host Address
This entry allows you to disable the display of the IP host address or gateway in
the Operator Information Area of the screen. The default is On. For example:
[System.Settings]
Display Host address = Off

Attn Format
This entry allows you to change the sequence used to send the SNA Attention
signal to the host system. IBM’s PC/3270 uses a different format than other
companies. If you want to use the IBM format,then use the following switch:
[System.Settings]
Attn Format = 1
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Printer Font
This entry allows you to change the default printer font used to print the keyboard
template from Times New Roman to any True Type font of your choice. For
example:
[System.Settings]
Printer Font = Arial

Max Winsock Receive Size
This entry allows you to change the default receive size issued to the TCP/IP stack.
By default, IntelliTerm uses a 20,000 byte block to receive data. You can lower this
value to solve problems in low memory situations. For example:
[System.Settings]
Max Winsock Receive Size = 4096

Prompt on Close Windows
By default Distinct IntelliTerm will warn you if you try to close the application and
a session is currently open. If you do not wish to be prompted before the program
closes, enter the following line in the [System.Settings] section:
[System.Settings]
Prompt On Close = Off

Large Toolbar
By default, Distinct IntelliTerm uses fairly small icons which are easily readable up
to 800x600 resolution. However, at 1024x768 and higher, the icons get somewhat
small. To use the larger set of icons in the toolbar, add the following line to the
[System.Settings] section:
[System.Settings]
Large Toolbar = On

You can also change the size of the buttons dynamically by right-clicking the
toolbar and clicking the Large Icons checkbox. The toolbar is resized
automatically as soon as you click OK.
Modify Tracing File
By default, the tracing file is created in the root of the current drive as
ITERM.TRC. To change the location and name of the trace file, add the following
line to the [System.Settings] section:
[System.Settings]
Trace Filename=F:\TESTPATH\NEWFILE.EXT
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Allow NumLock Maps
By default, the plus and minus keys in the keypad area cannot be remapped when
the NumLock key is toggled on. To allow these keys to be remapped even with the
NumLock toggled on, add the following line to the [System.Settings] section:
[System.Settings]
Allow NumLock Maps=On

Type Ahead Timeout
By default, the Type Ahead will automatically timeout waiting for the host system
to unlock the keyboard after 45 seconds. You can change this timeout by entering
a new value in seconds using the following option in the [System.Settings] section:
[System.Settings]
Type Ahead Timeout=xx

Capture OIA
By default, the Operator Information Area (OIA) is also saved to the file when the
Save Screen function is executed directly or via the dialog box. You can prevent the
system from saving the OIA by adding the following line to the [System.Settings]
section:
[System.Settings]
Capture OIA=Off

Display Field Info
By default, the system updates the Numeric Field and Operator Selectable Field
indicators in the OIA every time the cursor is moved. If this causes too much
overhead on your machine, (i.e. cursor movement appears slow), then disable it by
adding the following line to the [System.Settings] section:
[System.Settings]
Display Field Info=Off

Maximum Sessions
By default, a user can allow up to twenty-six concurrent sessions with Distinct
IntelliTerm. You can further the amount of sessions to a lower value by adding the
Maximum Sessions line to the [System.Settings] section. Replace x with a value
from 1 to 5 (inclusive).
[System.Settings]
Maximum Sessions=x
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Host Language Support
You can change the host language after installation by changing the language name
in the [System.Language] section. The valid language names are: USEnglish,
UKEnglish, Swedish, AustrianGerman, CanadianFrench, and Norwegian.
For example:
[System.Language]
Language = Swedish

ReRun Auto Quick-Key
By default, the Auto Quick-Key is executed when a session is initially created. It is
also re-executed when the session is recreated using the “Auto Reconnect” feature.
To prevent this from occurring, add the following line to the profile that you wish
to disable the feature. For example, if the profile name is MVS, then search for the
[MVS] section and add the ReRun Auto Quick-Key=Off line somewhere.
[...profile name...]
ReRun Auto Quick-Key = Off

Poppads
Distinct IntelliTerm supports a fully redefinable poppad. A poppad is a small
window which contains the most popular action keys or macros. You can display
up to five different poppads concurrently.
To enable the default poppad, select Default Poppad from the View/Poppad menu.
The following window will appear:

The poppad is designed as a floating window which always stays on top of any
session window on your desktop. To press any of the keys, simply move the mouse
pointer over a button and press the left mouse button to perform the action. The
action is sent to the last active terminal window. For example, if you have multiple
sessions active, the window whose title bar was last active will receive the action.

Loading a Custom Poppad
To load a custom poppad that you previously saved to a profile, select the
Poppad/Custom option from the View menu. The Load Profile dialog box
appears. Select the profile you want to load and select OK.
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Resizing the Poppad
To resize the poppad, simply drag any edge of the window and change the width
to your desired size. Distinct IntelliTerm will resize the box to match the width as
best as possible.
Distinct IntelliTerm will remember the position and format of the poppad when
you exit the program so that next time it will appear in the same shape and
location as before.

Configuring the Poppad
To configure the poppad, select the Poppads command from the
Options/Terminal Settings menu. The Configure Poppad dialog box appears.
You can configure the poppad to contain any function or macro you want. You
can also set the text that appears on each button.

Modifying a Poppad Entry
To modify an existing entry, first select the entry you want to change by clicking
on it in the list box. Next change the text that will appear on the button and/or
change the function that will be executed when the button is selected. Then select
the Change button.
To move the entry up or down press the Move Up or Move Down buttons
respectively.
To delete an entry, select the entry and press the Delete button.
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Adding New Poppad Entries
To add a new poppad entry, enter the button text in the Button Text box and
select the appropriate command or macro to execute and then press the Add
button. The entry will be added to the end of the list. Then use the Move Up and
Move Down buttons to position the entry in the list.

Poppad Profiles
You can load and save multiple poppad profiles. After changing the entries, press
the Save button to save a poppad profile. You will be presented with the familiar
Save Profile dialog box. Enter the profile name and select the Save button. You can
also load a poppad profile in the Configure Poppad dialog box, rename, and then
save it.

Track Menu
The Track Menu is a floating pull down menu which can be attached to any of the
mouse button functions. By default, to access the Track Menu, press
Ctrl-Shift-Right Mouse button. When you activate the Track Menu, it will appear
at the mouse pointer. The track menu in a 3270 session looks like this (the track
menu in a VT session differs slightly):

To select an entry, use the mouse and select the action you want to perform or
press the appropriate accelerator key sequence.
If you display the track menu and do not want to perform any action, simply click
anywhere else on the screen and the menu will disappear.
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Hotspots
The hotspots feature allows Distinct IntelliTerm to press action keys by analyzing
the text on the terminal screen. For example, many 3270 electronic mail packages
have the PF key legend at the bottom of the screen. The format is usually
something like:
“PF2:Read, PF3:End”

If you double-click the left mouse button on any point of the PF2 text, Distinct
IntelliTerm will press PF2 automatically.
There are three default groups of hotspots which are enabled when you use
Distinct IntelliTerm for the first time. They are listed in the Define Hotspots
dialog box.
The text legends must be delimited on the left side with a blank, null character or
field attribute. The right delimiter must be a blank, colon, equal sign, or a field
attribute.
For example, the system would be able to interpret the line:
“ PF2:READ ”

But it would not be able to interpret the line:
“ ,PF2:READ ”

In the latter, the offending character is the comma beside the word PF2.
To access the Define Hotspots dialog box, select Hotspots from the Options
menu.

In the dialog box shown above, the text “More...” will activate the F2 key.
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Adding New Hotspots
You can assign system commands, action keys, editing keys, quick keys or macros
to a Hotspot Text.
To add a new hotspot, first enter the text you wish to use as the hotspot text. Next,
select Commands or Macros to view the available commands or macros in the list
box. Finally, select an action in the list box and click on the Set button. The new
combination will be added to the Hotspot Text list box, and the selected action
will appear in the Hotspot Action box.
There is no limit to the number of hotspot entries that you can add. Hotspots are
saved for each terminal type. This means that hotspots defined for 3270 ttype
sessions will not be visible from VT type sessions and vice versa.
The option Case sensitive hotspots is a system wide feature. Checking this option
will affect all hotspot entries currently defined.

Deleting Hotspots
To delete a hotspot definition, select the hotspot text in the list box and select the
Delete button.

Saving Hotspot Entries
All Hotspot entries and options are automatically saved to a global profile when
you select the Close button. They are saved in the ITERM.INI file in your
Windows directory. You do not need to save your user profile in order to save the
hotspot entries.

Viewing Hotspots
To view hotspots, check the Show Hotspots item in the Display category of the
Session Profile dialog box. This will display the hotspot text as black text on a gray
background.

Working with Fonts
Distinct IntelliTerm requires fonts that have equal character spacing. These are
called Fixed-Pitch fonts (as opposed to Proportional fonts). Fixed-Pitch fonts are
required so that the text on the screen appears in consistent positions on the
screen. Additionally, since Distinct IntelliTerm is a terminal emulator and not a
word processor, the main window must be a specific size given a certain font.
Distinct IntelliTerm fully supports the use of True Type fonts. It also provides a set
of crystal clear bitmap fonts which are preferable at resolutions ranging from VGA
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(640x480) to SVGA (1024x768). To select these fonts, choose Select Font from
the Fonts menu then select TCP Terminal as the font name.

The windowing system used by Distinct IntelliTerm operates in two ways. In
AutoFontSizing mode (which is the default mode of operation), you can drag the
bottom, top, or corners of the window frame to make it smaller or larger and the
program will dynamically change the window size.
You can change the session fonts by choosing Select Font from the Fonts menu.
You can enlarge or reduce the font size by using the menu options from the Fonts
menu or by selecting the enlarge or reduce buttons from the toolbar. The enlarge
and reduce functions work in both Normal and AutoFontSizing modes.
The Select Session Font dialog box will list all available bitmap and True Type
fonts that match the characteristics required by Distinct IntelliTerm. Although the
Font Style list box will allow you to modify the font, Regular style is normally the
preferred style. As you change the Font, Style, and Size, a sample of the new font
will appear in the Sample group box. As you select fonts of various types and sizes,
the Window Preview will show you what size the window will occupy on your
desktop with the currently selected font. Once you have selected the font you
desire, press the OK button to change the session font. Distinct IntelliTerm will
then resize the window to the size required by the new font. The Session Font
options in the Font category are described in the section “Session Options.”

Saving Fonts and Window Positions
To save the font size and window position to the profile, you must save the profile
by selecting the Save Session Profile option from the Options menu or Save from
the Session Profile dialog box. Check the Save Window Layout in Profile checkbox
before saving the profile to disk. Otherwise, the font and window position will not
be saved.

Session Font Options
There are a number of options that are available in the Session Options to control
the display system.
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Keep Font Aspect Ratio
When you resize the window, Distinct IntelliTerm can either generate fonts that
match the window size as much as possible or it can generate fonts which are
always visually correct. With the option checked, Distinct IntelliTerm always
generates fonts that are visually correct. You cannot create fat or narrow fonts in
this mode. To create fonts that match the window size more precisely, clear this
option.
Display 3D Borders
When you resize the window and Distinct IntelliTerm generates a new font, it is
impossible for the system to create a font that matches the exact window size.
When this option is checked, the system will center the terminal area in the
window and fill the void around the window with a gray 3D like border. This in
effect ‘frames’ your session. To get a black frame, clear this option.
Force Exact Window Terminal Size
When you resize the window, Distinct IntelliTerm normally centers the terminal
area in the window and either fills the borders with a gray or black color. If you
want to force the system to always create a window that is the exact size of the
terminal window, check this option.

/

With this option checked, you will not be able to maximize the
screen.

Save Font & Window Info on Exit
This option when enabled saves the font information and window position and
size to the profile automatically.
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Default/Alternate Switching Mode
This option controls how Distinct IntelliTerm functions when it switches between
the default and alternate terminal size. This occurs only if you select a Model 3, 4,
or 5 terminal for a 3270 or if the VT terminal received commands to change the
window size.
The first option, Keep Font Size Constant, instructs the system to always use the
same font size when it switches modes. This causes the system to change the
window size as the terminal switches modes. The advantage of this option is that
you will always be able to read the font. However, this option does not work when
the screen is maximized.
The second option, Keep Screen Size Constant, instructs the system to always keep
the screen size constant. Therefore, when the system switches modes, it
automatically selects the largest font that fits within the current window size. This
option is selected by default.
The last option, Keep 3270 Modes Independent (valid only in 3270 mode), allows
you to select the position and font type independently in Default and Alternate
terminal modes. Once the system switches to and from each mode, it remembers
the size and type of font and the size and position of the window. This provides
maximum control of the display system.

Translate Tables
Although Distinct IntelliTerm for Windows supports several languages, you can
tailor the EBCDIC to ASCII translate tables used for display and entry of data.
The reason why there are translate tables is that IBM host systems use a data
format called EBCDIC (Extended Binary Coded Decimal Interchange Code). This
defines the value of all alphanumeric and other characters in a byte. All 3270
devices use the EBCDIC data format. On the other side, all PCs use the ASCII
format (American Standard Code for Information Interchange) to interpret data
bytes. Therefore, PCs must translate the host data from EBCDIC to ASCII in
order to display it properly and also translate the input ASCII data to EBCDIC to
send data to the host.
There are 2 translate tables that operate independently. The first table,
EBCDIC-to-ASCII is used to convert data received from the host for display
purposes. The second table, ASCII-to-EBCDIC is used to convert data entered
from the keyboard to send to the host system.
Distinct IntelliTerm uses a Global table set and can optionally use Private Translate
Tables. The Global table set is used by default for all 3270 and 5250 terminal
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sessions. However, you can override the global tables within the Session Profile
and choose a different translate table set.
To access the Global Translate Tables you must be in 3270 or 5250 mode. Select
Global Translate Tables from the Options menu. The following dialog will appear.

You can display and enter data in either Decimal format (base 10) or Hexadecimal
format (base 16) by selecting the Display Type.
To change an entry, move the scroll bar in the appropriate table and enter a new
value in the correct base format. For decimal, you can enter numbers from 0 to
255. For Hexadecimal, you can enter values from 00 to FF.
The dialog is designed to always display the opposite translation. This allows you
to easily see the current reverse translation.
Once you have completed your changes, press OK to save the new translation
tables immediately to disk.
Changes in the translate tables affect all terminal sessions.

Changing the Global Host Language
Distinct IntelliTerm supports a number of host languages directly. To change the
host language after installation, you must edit the ITERM.INI file using any text
editor and change the line “Language=” in the [System.Settings] section.
The following host languages are available:
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USEnglish
UKEnglish
Belgian
Swedish
Norwegian
AustrianGerman
CanadianFrench
Changes to the host language take effect when you reload Distinct IntelliTerm.

Entry Assist
Distinct IntelliTerm’s Entry Assist function enhances the ability to create and edit
text material such as memos, letters, reports, and lists. Unlike real 3270 or 5250
terminals, Distinct IntelliTerm’s Entry Assist functions do not require support
from the IBM host editors or the IBM host system.
With Entry Assist enabled, the following extensions are available:
• Word wrap
•

Columnar tabbing

•

Audible end-of-line signal (Bell)

•

Cursor Position Display

• Definable HOME Position
TN3270 and TN5250 provide cursor word positioning, word delete, and tab to
end-of-line functions without requiring Entry Assist to be enabled.
Unlike other emulators, the Word Wrap feature can work within preset margins or
can automatically use the field width as the left and right margins. This allows you
to easily use Word Wrap from system to system without constantly setting the
margins.
You can set the Entry Assist features by selecting Session Profile from the Options
menu, and then choosing the Entry Assist category.

Enabling Entry Assist
To enable Entry Assist, press the Ctrl-E key sequence from any 3270 session. This
will enable Entry Assist only for the current session. The DOC indicator will
appear in the OIA. If it does not appear, press Ctrl-E again.
Enabling Entry Assist will first provide a cursor position indicator in the OIA. As
you move the cursor, the indicator will provide the location of the cursor in a
row/column format. A value of 1/1 is the upper left hand corner and a value of
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24/80 is the lower right hand corner (for a Model 2 terminal). At this time, the
end-of-line signal and columnar tabs are enabled. If Word Wrap was previously
enabled, it will automatically be enabled at this time. A >> (double right arrow)
will display beside the DOC indicator. To toggle Word Wrap, press the Ctrl-W
key sequence.
With Word Wrap enabled, the cursor (and word) will automatically wrap to the
next line as you reach the right margin. If you are not in the Insert Mode, then the
next line (input area between the margins) must be clear and unprotected.

Changing the Margins and Tabs
To change the Entry Assist parameters, select the Entry Assist category from the
Session Profile dialog box.
To set any of the margins, move the cursor to the entry area and type in a valid
column number. For Model 2, 3, and 4, the valid column ranges are 1 through 80
inclusive. For Model 5 terminal, the column range is 1 through 132.
You can set the right margin as a normal margin which will either lock the
keyboard or wrap the text (if word wrap is enabled). The Alternate right margin
allows you to type over and past the right margin when word wrap is disabled.

You can set the column tab in two ways. First, move the cursor to the Tab Stops
entry area and enter a valid column number. Then click on the Set button to record
the value.
The second way is to set columnar tabs visually. Click in the Tab Stops entry area
and simply move the dialog box from over the main 3270 or 5250 window (do
not close it) and click anywhere on the 3270 or 5250 screen. The column location
will be calculated and automatically added to the Tab Stops list box.
To clear a tab setting, select the tab stop entry and then click on the Clear button.
To remove all tab stops, click on the Clear All button.
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Saving Entry Assist Options
After making changes in the Entry Assist category, click on OK to save the changes
for the current session.
You must click on the Save button and save the current session settings to a profile.

Security Features
Distinct IntelliTerm allows you to disable a number of its menu options and
features.

Disabling the Menu Line
To disable the menu line, add the following line to the section [Disable.Settings] in
the ITERM.INI file in your private Windows directory. If the section does not
exist, add it at the end of the file.
[Disable.Settings]
Display Menu=Off

Disabling Menu and Toolbar Commands
To disable menu and toolbar commands, add the line to the [Disable.Settings]
section in the ITERM.INI file in your private Windows directory. Always add the
option name followed by “=Off” in the file.
Command

Meaning

Start Sessions

Disables the Open Session dialog box and prevents
the user from creating any new sessions.

End Sessions

Prevents the user from terminating a session. It also
disables the system Close menu.

Exit

Prevents the user from exiting the application.

Printing

Prevents the user from initiating any printing
operations. This option does not disable any
host-initiated printing options.

Saving Screens

Prevents the user from saving any 3270 screens.

Capturing

Prevents the user from toggling the Capture option.

Uploads

Prevents the user from Uploading files to the host.
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Downloads

Prevents the user from Downloading files from the
host.

Saving Profiles

Prevents the user from saving any system-wide or
session specific profiles, including keyboard profiles.

Loading Profiles

Prevents the user from loading any profiles from
disk.

Change EHLLAPI

Prevents the user from changing the EHLLAPI
association settings.

Change Hotspots

Prevents the user from changing the hotspot settings.

Change Keyboard

Prevents the user from changing the normal
keyboard configuration.

Change Quick-Keys

Prevents the user from changing the macro
configurations.

Change Poppad

Prevents the user from changing the poppad
configurations.

Change Options

Prevents the user from changing any session options.

Change Toolbar

Prevents the user from modifying the toolbar
options.

Change Translate

Prevents the user from changing the Translate
Tables.

Change AutoSave

Prevents the user from toggling the AutoSave
feature.

Toolbar Status

Prevents the user from toggling the Toolbar status
(Display or Hide).

Run Program

Prevents the user from running an external program.

Macro Edit

Prevents the user from accessing the Macro Editor.

Macro Run

Prevents the user from running a macro.

Macro Stop

Prevents the user from stopping a macro.

Macro Continue

Prevents the user from continuing execution of a
macro.

Find

Disable the user from searching the scrollback buffer.

2-38

Distinct IntelliTerm Sessions

Disabling Session Profile Categories
To disable Session Profile Categories, add the desired line to the [Disable.Settings]
section in the ITERM.INI file in your private Windows directory. Always add the
option name followed by “ = Off” in the file. Categories disabled by these
commands affect all sessions and profiles.
Command

Description

Category 3270

Prevents the user from changing the 3270 model.

Category Colors

Prevents the user from changing the colors.

Category Color Palette

Prevents the user from changing the color palettes.

Category Cursor

Prevents the user from changing the cursor type.

Category Display

Prevents the user from changing display features.

Category Entry Assist

Prevents the user from changing Entry Assist
features.

Category File Transfer

Prevents the user from changing file transfer defaults.

Category Font

Prevents the user from changing font features. This
does not prevent a user from changing the session
font.

Category General

Prevents the user from changing general features.

Category Host

Prevents the user from changing host features.

Category Mouse

Prevents the user from changing mouse features.

Category Print

Prevents the user from changing printing features.

Category PCPrint

Prevents the user from changing PCPRINT features.

Category Save

Prevents the user from changing save features.

Category Toolbar

Prevents the user from modifying the session toolbar
options.

Category Translate Tables

Prevents the user from modifying the session
translate tables.

Category Window Title

Prevents the user from changing window titles.

Category VT Character Sets Prevents the user from changing the VT Character
Sets.
Category VT Display

Prevents the user from changing the VT Display
features.
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Category VT Keyboard

Prevents the user from changing the VT Keyboard
features.

Category VT Model

Prevents the user from changing the VT Model.

Category VT Preferences

Prevents the user from changing the VT Preferences.

Category VT Screen

Prevents the user from changing the VT Screen
features.

Category VT Tabs

Prevents the user from changing the VT Tab
positions.

Example
The following example prevents the user from hiding the toolbar and changing any
session or system options. It also hides the menu line.
[Disable.Settings]
Display Menu=Off
Change Hotspots=Off
Change Keyboard=Off
Change Macros=Off
Change Poppad=Off
Change Options=Off
Change Translate=Off
Change AutoSave=Off
Toolbar Status=Off
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TN3270 File Transfer

Distinct IntelliTerm supports file transfer to the following IBM host
operating systems: VM/CMS, MVS/TSO, and MUSIC/SP. When
transferring files, you must not be executing any program on the remote
system since a host program will be invoked to do the file transfer.
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Preparing for File Transfer
File transfers are always initiated from the workstation program. You cannot start a
file transfer by typing a command at your host system prompt.
• When using CMS, you must be at the “R;” prompt. For file transfer with
CMS, do not forget to start the options list with an open parenthesis “(”, or
add the “Set Cmsxfer On” command to the ITERM.INI profile.
•

When using TSO you must be at the “READY” prompt. You cannot be in any
SPF panel when starting a file transfer.

•

When using MUSIC you must be in the “*Go” mode. Make sure that the
screen will not enter the “More...” mode, or the file transfer will fail.

Uploading
To send a file to the host:
1 Select the Send (upload) option from the Transfer menu or press the upload
button on the toolbar.
2

The Upload a File dialog box allows you to select the PC file to upload, the
destination filename and file transfer options. Select the filename. As you do
so, Distinct IntelliTerm will automatically enter that filename in the PC File
Name text box correcting the name for the destination system.
You can also upload files from disk or from the Windows clipboard if it
contains suitable data. If data is available from the clipboard, then the Upload
from group box will be available and you can select either Disk or Clipboard as
the source. If you select Clipboard, you do not need to select a filename.

3

As you select the source, Distinct IntelliTerm automatically enters that
filename in the Upload to (Host File Name) text box. You may change this
name if you wish to.

4

To start the file transfer, press the OK button.
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The File Transfer Monitor dialog box appears to display the number of bytes
that are transferring.

Downloading
To receive a file from the host:
1 Select the Receive (download) option from the Transfer menu or press the
download button on the toolbar. The Download a File dialog box appears.
2

Enter the host file to download in the Download from (Host File Name) text
box.

3

Choose a local directory to download the file to. If you want to change the
name of the file, enter a new one in the PC File Name text box.
You can download a file directly to the Windows clipboard by selecting the
Clipboard in the Download To group box. Files that are downloaded to the
clipboard are placed in CF_TEXT format, which is a text format supported by
most applications.

4

Select your file transfer options.

5

To start the file transfer, press the OK button.

/

You can select a filename before selecting the download dialog
box. Using the mouse, select the name of the host file you wish
to download from a line of screen text. Then select Receive
(download) from the Transfer menu. The host filename will be
copied from the highlighted text to the Host File Name text
box.
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General Options
The General Options group box for uploading or downloading allows you to
specify whether you are transferring text or binary files and whether you want to
append the file being transferred to a previously existing file. Either select ASCII
and CRLF for an ASCII transfer or deselect both of them for a binary transfer.
ASCII

Specifies ASCII to EBCDIC translation. This option
should be checked when transferring text files.

CRLF

CRLF is the carriage return and line feed code. (These
control words are needed for viewing or editing text
and source files, such as SCRIPT files. They are not
required for binary files). This option should be
checked when transferring text files.

APPEND

Specifies that the file being sent should be added to the
end of the host file. (Omit this part if you want the file
to replace an existing host file).

Specific Host System Options on Upload
The following tables describe the options for CMS, TSO, and MUSIC when
uploading:

CMS Specific Options
The CMS Specific Options include the following:
Record Format
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The file format used to create the receiving file on the
host system. The Default format is set to Variable.
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LRECL n

The record length of the file uploaded to the CMS file
system. (Include a record length only if you want the
file you send to have a record length other than 80.
Replace the n with the length you want. If you omit
this option, the file will have a record length of 80).

TSO Specific Options
The TSO Specific Options include the following:
(member)

The member name can be appended to the host
filename if the file is to be put into a partitioned data
set.

/password

The password can be appended to the host filename if
the data set has one.

Record Format

The file format used to create the receiving file on the
host system. The default type is Variable. Do not use
this option with the member name option.

LRECL n

The record length for a new data set on your TSO
volume: n = 1 through 132. (If you want to set the
record length for a new data set, replace the n with the
length you want. If you omit this part, you will get a
record length of 80. Do not use this option with the
member name option.)

BLKSIZE n

The size of the blocks of data in a new data set on your
TSO volume. (If you want to set the block size for a
new data set, replace the n with the size you want. If
you omit this part, the block size will be the same as the
record length. Do not use this option with the member
name option.)

MUSIC Specific Options
The MUSIC Specific Options include the following:
LRECL n

The record length for a new save file on your MUSIC
code: n = 1 through 32767. (If you want to set the
record length for a new save file, replace the n with the
length you want. If you omit this part, you will get a
record length of 80.)

Record Format

The file format used to create the receiving file on the
host system. The default type is Variable.
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Errors
If the file transfer hangs, return to the terminal session and press PF2 until you
return to the operating system prompt. (You may have to press ESC to unlock the
keyboard.) This is usually caused by the screen changed to the “More...” mode or a
message which changed the state of the screen.

Canceling SEND or RECEIVE
You can cancel a file transfer initiated by the SEND or RECEIVE panels or
commands by pressing the Cancel button in the File Transfer Monitor dialog box.
This will attempt to terminate the file transfer normally. If the transfer appears
hung, you can press the Exit button to abort the file transfer immediately.

Changing File Transfer Options
There are a few features that you can change which affect file transfers. These
options can be customized by selecting Session Profile from the Options menu and
then selecting the File Transfer category. You can instruct TN3270 to perform a
key action before initiating the file transfer. This is useful if you need to clear or get
by some initial panel. You can also select a block size from 512 bytes to 9999
bytes. The larger block size will yield in a higher file transfer rate, however, the
smaller block size is preferable when transferring data from a remote site through
slow links.
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Changing the File Transfer Program Name
You can change the file transfer program name from IND$FILE to whatever
command you wish executed. This feature is primarily used to execute another
system command before executing the actual file transfer program.
To change the file transfer program name, select the File Transfer category from
the Session Profile dialog box. You can change the name to whatever you like.
There is no validation performed on the name entered.
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Keyboard and Macros

With Distinct IntelliTerm, you can fully redefine the keyboard to a layout
of your choice. In addition to assigning a system function to a key, you can
also assign a macro to a key. A macro is a collection of system functions,
facilitating the automation of tedious typing operations. This chapter also
includes a full listing of the default keystrokes.
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Keyboard Mapping
To change the keyboard layout, select Keyboard Mapping from the Options menu.
The Keyboard Mapper dialog box appears.

Changing a Key Mapping
The keyboard can be remapped using a Drag-and-Drop method, or by using the
keyboard. To change a key mapping:
1 Select the key that you wish to redefine by clicking on that button in the
Keyboard Mapper dialog box. The Current Key group box shows you what is
currently assigned to that key.
You can assign system functions to four possible key combinations: Normal,
Shift, Control, and Control+Shift.
2

To assign a command, macro, or character to the key, select the appropriate
item in the Function list box with the mouse. Select one of the options in the
Show group box. As you select items in any set, you will notice that the
Description box contains a description of the command, macro, or character.
Commands: System commands and functions (e.g. PF1 & Cursor Left).
Macros:

Macro commands currently defined and available.

Characters: Any ASCII character in current Windows Language setup.
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3

Keep the left mouse button pressed and drag the item over to one of the four
key states in the Current Key group box.
Notice that as you drag the item, the pointer will change between a square and
a do-not-enter sign. When the pointer is a square, you can release the mouse to
assign the function to the key or key state under the pointer. When the pointer
is a do-not-enter sign, releasing the mouse will not perform the action.

You can drag the function directly over any key button in the dialog box to
assign it to the Normal state of the key. For example, if you select the Reset
function and drag it and release it over the Esc key, the Esc key will be
assigned the Reset function. This will not affect the Shift-Esc, Ctrl-Esc, or
Shift+Ctrl-Esc combinations.
You can also assign a key by selecting the function and pressing the set button. The
function will be assigned to the mode selected for the current key.
4

Resetting a Key Mapping
To reset a key (all states) to its default value, select the key and then click on the
Default button. To clear an entry to a null value, select the key combination and
then click on the Clear Entry button.
Once you have completed your changes, you can click on OK to save the changes
only for the current session, or click on Save to save the changes to a profile.

Resetting All Key Assignments
To reset the entire keyboard back to the default setting, click on the Reset All
button. You will be prompted to confirm your request before the entire keyboard
mapping is reset to its default state.

Viewing and Printing Current Key Assignments
To view the current key assignments, that is, if you want to know what key
performs a given action, click on the List Assigned Functions button. The Current
Keyboard Template dialog box appears.
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To print the current keyboard template, click on the Print button. This will format
the current keyboard template and print it on the printer of your choice. You can
change the font used to print the text. See the “Default Keystrokes” section for
more help with the current key assignments.

Quick-Keys
Distinct IntelliTerm supports the defining of Quick-Keys. A quick-key is a
collection of keystrokes that can be easily referenced and assigned to keys.
To create, edit, and delete macros, select the Quick-Key option from the Terminal
Settings command in the Options menu.
Quick-Keys can contain two types of objects—quoted text strings and system
commands. A quoted string is an ASCII string enclosed by double quotes. The
sample dialog box above has some quoted text. A system command is one of the
system commands displayed in the list box.

Creating a Quick-Key
To create a new Quick-Key:
1 First enter the Quick-Key name in the Quick-Key Name text box.
2

Tab to the Assigned Quick-Key String text box and enter the Quick-Key
string. A Quick-Key can be up to 1000 bytes long and contain an unlimited
number of strings and commands. All words must be separated by a space. For
example, you must have a space between system commands and quoted
strings.

3

To add system commands to the Assigned Quick-Key String edit box, simply
click on the function and then press the Append function. The program will
append the command name and add a space if necessary.
When you select System Commands, their descriptions display in the
Description box.

4

Click on the Set button to save the Quick-Key.
Once you have added the Quick-Key(s) you want, you can run them by
selecting them in the Quick-Key name text box, and clicking on the Run
button.

Editing a Quick-Key
To edit an existing Quick-Key, select the Quick-Key name in the list box of
existing Quick-Keys. This will copy the name to the Quick-Key name text box and
copy the value to the Assigned Quick-Key String text box. Change the Quick-Key
as desired and then click on Set to save the new Quick-Key value.
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Renaming a Quick-Key
To rename a Quick-Key, select the Quick-Key name in the list box of existing
Quick-Keys. This will copy the name to the macro name text box and copy the
value to the Assigned Quick-Key String text box. Then, change the name to the
new name and click on Set to save the new Quick-Key. Delete the old Quick-Key
by selecting the old Quick-Key name and clicking on Clear.

Deleting a Quick-Key
To delete a Quick-Key, select the Quick-Key name in the list box of existing
macros. Then click on the Clear button to delete the entry.

Special Quick-Key Functions
There are some special functions which are available only in Quick-Keys. These
functions can be used to automate certain operations.
IPause

The Intelligent Pause function can be used to
synchronize AID generating keys. This function
causes the Quick-Key to pause for up to 5 second or
until the 3270 keyboard unlocks, whichever comes
first. You can insert more than one IPause function if
you need to wait for a longer time.

Pause

The Pause function can be used to synchronize AID
generating keys. This function causes the macro to
pause for a ½ second interval regardless of the state
of the keyboard. This can be useful if you want a
macro to press multiple AID generating keys.

Password

The Password function can be used to type the
contents of the Password edit field stored in the
session profile. This allows you to save a password
(encrypted) in a profile and use it without knowing
its contents. The password text is only entered if the
current field is a non-display field.

Prompt-Password

The Prompt-Password function can be used to
prompt the user for a password. The contents of the
password are stored in an internal variable which can
be entered into a hidden field using the Password
command described above. For example, if you
wanted to create a script that logged you into CMS
automatically, your Quick-Key might look
something like this:
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Home Prompt-Password “CMSUSER” Tab
Password Enter
This Quick-Key presses the Home key, prompts for
the password, enters a user id called “CMSUSER”,
presses the Tab key, enters the password contents,
and presses the Enter key.
Run

The Run function allows you to run an external
program
directly. The function and options are passed by
entering text immediately after the Run command in
a macro. For example:
Run “NOTEPAD.EXE C:\CONFIG.SYS”
When using the Run function, a text string must
follow the Run function. The text string contains the
full command name and any command line options.
Any other functions entered after the string are
ignored.

Start-Session

The Start-Session function allows you to start a new
terminal session. The function is passed by entering
text immediately after the Start-Session function in a
Quick-Key. For example:
Start-Session “profilename”
When using the Start-Session function, a text string
must follow the Start-Session function. The text
string contains the profile name. Any other functions
entered after the string are ignored.

Default Keystrokes - 3270 Mode
The following table is a list of the default 3270 keystrokes when Distinct
IntelliTerm is first loaded.
Some EBCDIC characters are mapped to ASCII characters on the keyboard. They
are: the not sign (^) and the vertical bar (|).
PC Key

3270 Function

Cursor Keys

Normal Cursor Movement

Shift Cursor Keys

Fast Cursor Movement (By 2’s) (Enhanced
Keyboards)

End

Move cursor to end of field

Ins

Toggle Insert Mode
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Enter

Enter

Ctrl-Enter

Newline

* (Keypad)

Newline

Home

Move cursor to Home position

Tab

Move cursor to next field

Shift-Tab

Move cursor to previous field

Ctrl-End

Erase to End of Field

Ctrl-Home

Erase Input

Ctrl-Left-Arrow

Previous Word

Ctrl-Right-Arrow

Next Word

Ctrl-Del

Delete to end of word

Backspace

Move cursor left and delete character

Esc

Reset (Unlock keyboard and clear Insert)

- (Keypad)

PA1

+ (Keypad)

PA2

/ (Keypad)

PA3

Pause

Clear

^

¬ (EBCDIC Not Sign)

¦

| (EBCDIC Vertical Bar)

Ctrl-6

¢ (EBCDIC Cent Sign)

F1-F12

PF1-PF12

(Enhanced Keyboards)

Shift F1-F12

PF13-PF24

(Enhanced Keyboards)

Enter (Keypad)

Enter

(Enhanced Keyboards)

F1-F10

PF1-PF10

(Normal Keyboards)

Shift F1-F10

PF11-PF20

(Normal Keyboards)

Ctrl F1-F4

PF21-PF24

(Normal Keyboards)

3270 Key

3270 Description

Ctrl-A

Create a new session
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Ctrl-B

Delete the current session

Ctrl-C

Copy highlighted block to clipboard

Ctrl-E

Toggle Entry Assist

Ctrl-G

Enable/Disable Attribute Display

Ctrl-H

Clear Type Ahead buffer

Ctrl-I

Insert text from clipboard

Ctrl-N

Jump to next session

Ctrl-P

Print current screen

Ctrl-Q

Terminate all sessions and exit IntelliTerm

Ctrl-R

Receive a file from the host

Ctrl-S

Send a file to the host

Ctrl-T

Cancel PCPRINT job

Ctrl-V

Paste text from clipboard

Ctrl-W

Toggle Word Wrap

Ctrl-X

Copy text to clipboard and cut

Ctrl-Z

Clear

Shift-Del

Delete highlighted text

Ctrl-Numpad-5

Select entire screen

Default Keystrokes - 5250 Mode
The following table is a list of the default 5250 keystrokes when Distinct
IntelliTerm is first loaded.
PC Key

5250 Function

Cursor Keys

Normal Cursor Movement

Shift Cursor Keys

Fast Cursor Movement (By 2’s) (Enhanced
Keyboards)

End

Move cursor to end of field

Ins

Toggle Insert Mode

Enter

Enter

Delete

Delete
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Ctrl-Enter

Newline

*

Newline

Home

Move cursor to Home position

Tab

Move cursor to next field

Shift-Tab

Move cursor to previous field

Ctrl-End

Erase to End of Field

Ctrl-Home

Erase Input

Ctrl-Left-Arrow

Previous Word

Ctrl-Right-Arrow

Next Word

Ctrl-Del

Delete to end of word

Ctrl-Ins

Edit copy

Shift-Ins

Edit paste

Alt-F4

Exit

Shift-Enh-Home

Field mark

Ctrl-F1

Help

Shift-Esc

System request

Backspace

Move cursor left and delete character

Esc

Reset (Unlock keyboard and clear Insert)

-

Field minus

+

Field plus

Pause

Clear

Ctrl-6

¢ (EBCDIC Cent Sign)

F1-F12

PF1-PF12

(Enhanced Keyboards)

Shift F1-F12

PF13-PF24

(Enhanced Keyboards)

Enter (Keypad)

Field exit

(Enhanced Keyboards)

F1-F10

PF1-PF10

(Normal Keyboards)

Shift F1-F10

PF11-PF20

(Normal Keyboards)

Ctrl F1-F4

PF21-PF24

(Normal Keyboards)

Ctrl-Numpad-5

Select entire screen
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5250 Key

5250 Description

Ctrl-A

Create a new session

Ctrl-B

Close the current session

Ctrl-C

Copy highlighted block to clipboard

Ctrl-D

Duplicate

Ctrl-E

Toggle Entry Assist

Ctrl-F

Field mark

Ctrl-G

Enable/Disable Attribute Display

Ctrl-H

Clear Type Ahead buffer

Ctrl-I

Insert text from clipboard

Ctrl-N

Jump to next session

Ctrl-P

Print current screen

Ctrl-Q

Terminate all sessions and exit IntelliTerm

Ctrl-R

Receive a file from the host

Ctrl-S

Send a file to the host

Ctrl-V

Paste text from clipboard

Ctrl-W

Toggle Word Wrap

Ctrl-X

Copy text to clipboard and cut

Ctrl-Z

Clear

Shift-Del

Cut highlighted text

Default Keystrokes - VT Mode
The following table is a list of the default VT keystrokes when Distinct IntelliTerm
is first loaded.
PC Key

VT Function

Cursor Keys

Normal Cursor Movement

Esc

Escape

Ins

VT420 Insert Here Function

Delete

Del

4-10

Keyboard and Macros
Home

VT420 Find Function

End

VT420 End Function

Page Up

VT420 Prev Function

Page Down

VT420 Next Function

Enter

Enter

Ctrl-Enter

LineFeed

Ctrl-1

PF1

Ctrl-2

PF2

Ctrl-3

PF3

Ctrl-4

PF4

F1

Hold

F2

Print-Raw

Ctrl-F2

Toggle Auto-Print

F3

Session Profile

Ctrl-F3

Power-On Reset

F4

Toggle Scrollback

F5

Break

Ctrl-F5

Send Answerback Message
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Printing

This chapter describes how IntelliTerm screens can be saved or printed. It
also describes how to print files from your host system to the PC printer.
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Printing and Saving Screens
Distinct IntelliTerm lets you print the current screen to a selected Windows printer
or save the screen image to disk.
To print the current screen image:
1 Select the Print Screen option from the File menu. The Print dialog box
appears.

2

If the printer displayed is not the printer you wish to print to, then click on
Setup and select the appropriate printer from the Name list box.

3

You can change the printer characteristics such as paper tray, duplex and other
options by clicking the Properties button. This pops up the Printer Driver
dialog box.

4

Click on the OK button.

Saving Images to Disk
You can save the current screen image to disk by selecting the Save Screen to Disk
option from the File menu. The Save Screen to Disk dialog box appears.

Select the appropriate directory, enter a valid filename, and click on OK to save the
screen image to disk. The image is usually appended to the file, unless you have
selected to overwrite it in the Save category.
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The Save As option lets you save the image using the ASCII (for DOS) or ANSI
(for Windows) character sets. The option is useful if you have characters with
accents, such as ä. The Save Mode option allows you to overwrite or append the
data to an existing file.

Capturing Distinct IntelliTerm Screens
3270 or 5250 Mode
You can instruct Distinct IntelliTerm to automatically capture all 3270 or 5250
screens to a file. Although this feature is similar to other terminal emulators, it
does not function identically due to the 3270 architecture.
When you enable capturing via the “Capture Screen” option under the File menu,
Distinct IntelliTerm begins to save all host updates to the save file (as set in the
Save Category for the Session Options). Each time that the host system updates
any portion of the 3270 screen, the entire screen is appended to the save file
(regardless of the Save Mode option). Unfortunately, this is the only way to
provide capturing in the 3270 architecture.

VT Mode
You can instruct the system to automatically save all lines received or even capture
all data received. The Capture Mode option in the Save Category of the Session
Profile determines how the system will capture data to the save file.
In Text mode, the system captures all data terminated by a LF, VT, or FF.
In Raw mode, the system captures all data received through the communication
link including control and escape sequences.

Printing Host Files
The PCPRINT utility is a program that runs on your host system that allows you
to print files from your host system to your PC printer. It is identical to
downloading the file and then printing the file but it does it in one step.

/

PCPRINT is far more efficient than TPRINT since it uses
2048 byte blocks. If you have a choice between the two, always
select PCPRINT.

PCPRINT for CMS
For CMS, PCPRINT utilizes the following syntax:
PCPRINT fn ft [ fm ] [ ( [ LPT1/LPT2/LPT3 ] [ CC/NOCC ] [ FF ] [ BIN ]
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PCPRINT for MUSIC
For MUSIC, PCPRINT utilizes the following syntax:
PCPRINT filename [ [ LPT1/LPT2/LPT3 ] [ CC/NOCC ] [ FF ] [ BIN ]

PCPRINT for TSO
For TSO, PCPRINT utilizes the following syntax:
PCPRINT datasetname [ [ LPT1/LPT2/LPT3 ] [ CC/NOCC ] [ FF ] [ BIN ]

Printing Options
The following options are available when printing host files.
CC: Directs PCPRINT to use the first column of every line as the carriage control
character.
NOCC: Directs PCPRINT to not use the first column as the carriage control
column. On CMS, TN3270 automatically enables the CC option for LISTING file
types.
FF: Directs PCPRINT to add a form feed at the end of the print job.
BIN: Directs PCPRINT to download the file in binary mode. By default, an
EBCDIC to ASCII conversion is performed. With the BIN option, the data is sent
directly to the printer, without performing this conversion.

Configuring PCPRINT Output
You can configure the output of PCPRINT jobs in the Print Category of the
Session Options dialog. Refer to the Print Category in the “Session Options” in
Chapter 2 for more information on the various options.

TPRINT
Distinct TN3270 supports Yale’s TPRINT facility by supporting the 7171
transparent data stream commands. In transparent mode, the program will support
the VT100 Printer On/Off escape codes to direct transparent output to the logical
printer port 1. Distinct TN3270 does support the 4994 inquiry command and will
respond with a VT100 terminal type.
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Host Graphics

TN3270 fully supports host graphics by emulating the following terminals:
3179G, 3192G, 3472G, and 3279 S3G. The system supports all vector
graphics commands and 6 Program-Symbol-Sets. Each terminal session can
perform independent vector graphics, however, the Program-Symbol-Sets
memory is common to all sessions. The system has been tested with popular
host graphics packages such as IBM’s GDDM ICU, AS, GDQF, CADAM,
SAS/GRAPH, CA-TELLAGRAF, CA-DISSPLA, EIA, ATREMIS,
NOMAD, FOCUS, RTPMS, and ACS graphics, as well as customized
GDDM applications. The system does not require any special configuration
options to use graphics. The graphics DLL is loaded automatically when the
first graphics data-stream is detected. You can save host images with
graphics to a file or copy them to the clipboard in the standard placeable
Windows MetaFile format. You can also print host images to any Windows
printer. It is recommended to disable Tool-Tips when using host graphics.
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Host Graphics Configuration
SAS/GRAPH
To display SAS/GRAPH graphics on your PC screen, include the following
GOPTIONS statement in your SAS program:
GOPTIONS DEVICE=IBM3179
OR
OPTIONS DEVICE=GDDM79
If you are using the SAS Display Manager with the graphics cursor, it is
recommended that you specify Resolution of TERMINAL in CONFIG under
Display in order for the graphics cursor to operate correctly

CA-TELLAGRAF
To display CA-TELLAGRAF graphics on your PC screen, include the following
statements in your TAGPRO file:
PRIMARY DEVICE IS IBM.
PRIMARY DEVICE MODEL IS 3179.

CA-DISSPLA
To use 3270 with CA-DISSPLA you must use the IBM 3179G device driver for
displaying graphics to your screen.

Boeing EIS
To use 3270 with EIS you must use the IBM 3279 device driver for displaying
graphics to your screen. This is done by including the following statement in your
data file:
OUTPUT 3279:
When using EIS with TN3270, we recommend that Model 3 terminal emulation
be used for best results.

UNIRAS
To use 3270 with Uniras you need to use the device driver for the IBM 3179G or
another GDDM device driver
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Trouble Displaying Graphics
Message: ADM0275 E GRAPHICS CANNOT BE SHOWN REASON CODE n
Several factors can cause this GDDM error message when attempting to display
graphics. Check each of the following items carefully in the order listed and take
corrective action:
5

The host (VTAM) logmode you are using must be a queriable logmode. By
default, your host LU is assigned a logmode which defines screen size and
queriability features. If you have a nonqueriable logmode, then graphics
cannot be displayed. Check with your VTAM systems programmer if you
think your logmode is not defined as queriable; tell them that the PSERVIC
parameter must start with ‘028’ or ‘02C’.

6

If your host uses a session manager such as CA-Supersession or TPX, the
session manager must be configured such that device query is supported.
Otherwise, graphics cannot be displayed because all host graphics applications
will perform a device query before sending its graphics data.

Reason Codes for ADM0275 E message:
5 The host logmode does not support extended data stream. Contact the VTAM
systems programmer to have extended data stream turned on.
6

The query failed. Follow steps 1 through 2 listed above.

7

The graphics DLL is not in the application directory or in the path. You
should have received a warning that graphics were not available. The file name
is NT3179G.DLL.

The graph is displaying, but not in graphics mode - it is using alphanumeric
characters to approximate the picture.
This usually means there is a logmode problem. For some reason the host
application software thinks that the device cannot display graphics so it sends
alphanumeric data instead. Make sure the logmode is queriable
(PSERVIC=’028...’).
When displaying CA-TELLAGRAF, CA-DISSPLA or Boeing EIS graphics the screen
seems to have shrunk.
This condition occurs because the CA-TELLAGRAF, CA-DISSPLA, and Boeing
EIS graphics packages make internal adjustments when using a 3270 screen size
other than Mod 3 (32 x 80). Change the logmode to Mod 3 and try again to
obtain better results OR set the value of Resolution to TERMINAL instead of
HIGH in CONFIG.
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SAS message:
ADMASPT NOT FOUND
This commonly occurs in VM/CMS when you specify the GDDM79 device driver
but the GDDM TXTLIBs are not being accessed in the VM/CMS session. SAS
requires the GDDM TXTLIB’s ADMGLIB and ADMRLIB.
We recommend that the IBM3179 device driver be used in place of the GDDM79
device driver. Then the GDDM TXTLIBs are not necessary.
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Distinct FTP Client

Distinct FTP Client is built on the File Transfer Protocol (FTP), providing
you with file transfer capabilities, a drag and drop interface, flexible
selection with wildcards, and an optional command line interface. File
transfer is the process of copying files from one machine to another. FTP is
the protocol in the Internet suite of protocols that allows you to log into
remote systems, look at the contents of remote folders, download files from
remote systems, upload files to remote systems, rename files and create folders.
With Distinct FTP Client, you can also drag and drop files between remote
systems. Distinct FTP Client allows up to 15 concurrent connections. You
can display one or two folder tree windows, each of which can display the
local file system and multiple connections, with a file list for the current
folder. Each folder tree can display up to three levels of folders, and allows
easy navigation through remote file systems as well as your local file system.
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Quick Start for Advanced Users
If you already know FTP, and want to quickly use the Distinct FTP Client for file
transfer, follow these brief instructions:
1 To start Distinct FTP Client, double-click on its program icon in the Distinct
program group or toolbar. You may also click on the FTP button in the Telnet
toolbar.When you start the client, the Connect to Host dialog box displays
automatically for you to make a connection.
2

To connect to a remote system, enter the host name or address, select a host
type (Autodetect is available), and enter your login information. If you need to
use a firewall, please refer to the section ““

3

To save the connection profile for future use, enter a Connection Name as well
and click on Save before you make the connection.

4

Click on Connect to make the connection. Once you are connected, you can
use the mouse to drag and drop files, or click on Download/Upload in the
toolbar or choose Download File(s)/Upload File(s) on the File menu, to
transfer files to or from the remote system. The initial (default) transfer mode
is ASCII, but you can change this to Binary using the toolbar or the Settings
menu.

To end an FTP session, click on Disconnect in the toolbar (File, Disconnect)
and then select the remote host from the drop-down list box, which shows the
first connection made at the top of the list.
Here are some extra tips for using the Distinct FTP Client:
5

©

To see the function of a toolbar button, move the pointer over it.

©

To split the window in order to display two independent file trees one above
the other, click on the Show Two Trees button in the toolbar or choose Show
Two Trees on the Window menu.

©

To display the Connect to Host dialog box when the client is already running,
click on Connect in the toolbar or choose Connect on the File menu.

©

After saving connection profiles, you can click on the Remote Connections
symbol to see a list of their names. To use one of the existing connection
profiles to make a connection, click on its name.

©

To move files from one remote system to another, establish two (or more)
connections, and then drag and drop the files.

/
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Notice the floating toolbar - you can resize it and dock it
along any side of the window
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Overview
Distinct FTP Client is a File Transfer Protocol (FTP) application. It makes
possible the sharing of files and the transfer of information stored in files within
and across TCP/IP networks. The Distinct FTP Client works in conjunction with
an FTP Server on each remote host.
The Distinct FTP client provides a toolbar, with buttons that you can use for quick
access to the most common operations, and a status bar showing toolbar button
functions and information on file transfer activities. The client also displays a menu
bar and the main window containing the file information.

/

This chapter tells you how to perform an operation by referring
to the toolbar button and then giving you the corresponding
menu option in brackets. For example: “To upload a file, click
on the Upload button in the toolbar (File, Upload File(s)).”

The Distinct FTP Client main window is split into a left and right side pane. The
left side pane initially lists your local disk drives and a Remote Connections symbol
giving access to user-defined connection profiles. You can expand a disk drive to
display a folder tree and to navigate to subfolders. The right side pane displays a
list of the files in the current folder, sorted by file name.
The folder tree on the left side of the Distinct FTP Client window can show you
up to three folder levels in the local or remote file system. There is a limit of 15 on
the total number of drives that can be displayed at the same time in any one tree.
The following describes the symbols on the drive and folder icons.
Shows that the folder or drive can be unfolded
Shows that the folder or drive can be folded up
Indicates no subfolders in the case of a local system
Indicates a drive (a pink drive icon indicates a remote drive)
Indicates the parent folder of the currently open folder (if any)
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Indicates an open folder
Indicates a closed folder
Indicates a folder that is a symbolic (or soft) link (in the case of
some remote systems such as UNIX systems). The word LINK is
in blue.
To fold/unfold a drive or folder, click on its name or plus/minus sign. Fold up the
part of the tree that you are not working on to keep the tree short and
manageable.

Symbolic Links
If the remote file system that you are connected to contains symbolic links, they
will appear in the Distinct FTP Client file tree with a different icon (shown in the
section “”). Symbolic links, also called soft links, let you use two or more different
names in different file systems for the same file. You cannot use the FTP Client to
create these links, but they may be created from a Telnet session.

One or Two Trees
The Distinct FTP Client can display one or two folder tree windows. You may find
it easier to work with folders in multiple file systems if you can see them in two
separate windows. To switch between one tree and two trees, use the toolbar
buttons or the options on the Window menu, please refer to the section “” later in
this chapter.

Drag and Drop File Transfer
To copy a file using the drag and drop method, click on a file in the right side pane
of the window and, holding the left mouse button down, drag the icon over the
destination folder and release the mouse button. The destination folder can be any
folder on the left side of the window. When you are working with two trees
displayed (Window, Show Two Trees enabled), the destination folder can also be
the right side of the other tree (current folder in that tree). Drag and drop works
for files on any connected remote system or your local system. To copy a group of
files, select all files, and then hold down the left mouse button, drag and drop.
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Resizable Panes
To adjust the sizes of the right and left panes in a file tree window, click on the
vertical split bar that divides them and drag it left or right. Similarly, to adjust the
sizes of the upper and lower windows when two trees are displayed, click on the
horizontal split bar that separates them and drag it up or down.

Resizable Columns
In the right pane(s), the file name, size, time last modified, and attributes of each
file are listed in columns with optional headers. To adjust the sizes of adjacent
columns, click on the split bar that divides them and drag it left or right.

Toolbar
The following summarizes the toolbar.
Open a connection
Close a connection
Stop a file transfer operation (upload or download) or the
displaying of a file list for a remote folder
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Download selected file or files
Upload selected file or files
Rename selected file
Delete selected file or files
Print selected file or files to an attached local or LAN printer

Set ASCII transfer mode for text files
Set binary transfer mode for non-text files
Create a folder under the selected folder

Show one tree only (the current upper one)
Show two trees
Display or modify the View options (file display)

See help information

Floating Toolbar
The Distinct FTP Client has a floating toolbar that you can place anywhere on the
screen. Position the pointer in the toolbar away from the buttons and drag it to a
new position using the left mouse button. Try a vertical toolbar at the right side of
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the window. If you want, you can resize the toolbar to be square instead of long
and thin. Depending on the file information displayed in the main window, you
can move the toolbar to an unused part of the window. If you approach an edge,
the toolbar will dock along the side of the window. When you start an FTP
session, the toolbar displays where it was at the end of the preceding session.

Status Bar
The status bar has three areas. The left area contains text showing you the result of
the last operation or explaining any button or function that the cursor is on. When
you are copying, an indication of how much has been copied displays in the central
area. The right area tells you the number and size of the selected files, if any, and
the total bytes transferred and transfer rate after a download or upload operation.

File Management Operations
Once you have established a connection to a remote host, you can download files
from the remote host to your local file system, and upload files from your PC to
the host. You can copy an entire folder, a subset of the files identified by
wildcarding, or individually selected files. With two or more connections, you can
also copy files from one remote host to another.
The File menu lets you do extra file operations as well as copying files, on remote
systems as well as on your local system. You can rename files or folders, delete files
or folders, and create folders. These operations all depend on your having the
necessary authorization. First make sure that the currently selected folder is the one
you wish to execute the command in.
The operations that may require confirmation are Copy, Delete and Print, where
Copy means any download or upload operation. Overwriting existing files may
also require confirmation. To enable or disable confirmations, choose
Confirmations on the Settings menu, please refer to the section “” later in this
chapter.

How to Abort an Operation
You can abort a network operation in progress by clicking on the Stop button in
the toolbar (File, Abort).

How to Exit
Once you have disconnected from all remote systems to which you were
connected, you may exit Distinct FTP Client by choosing Exit on the File menu. If
you still have active connections, FTP Client will ask you if it can close all
connections and exit or if you want to cancel your exit request.
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How to Use Distinct FTP
The Distinct FTP Client lets you connect to other systems and perform operations
on files on those systems as well as on your local files. The operations you can
perform are upload and download, copy, rename, delete, print, and create folder.
Any machine you connect to must be configured to act as an FTP server. To make
an FTP connection to an FTP server, you must have a valid login name and
password for a user account on that system. The permissions granted to the user
account determine which folders you will have access to, and which combination
of Read, Write, List and Delete access you will have to the files. Some servers on
the Internet allow you to log in as an “Anonymous” user. Some anonymous FTP
accounts require you to give your email address in the Password text box for
anonymous login authentication.
With no active FTP connection, you can use the Distinct FTP Client to view the
files on your local drives and to perform local copy, rename, delete, or print
operations, or to create local folders.

How to Connect to a Remote System
If you have just started the FTP client, the Connect to Host dialog box is displayed
on your screen. If this dialog box is not displayed, click on the first toolbar button
(File, Connect) to display it. The following decribes the mandatory and optional
information used to make your FTP connection.
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Text Box

Description

Connection Name
(Optional)

Enter a name to identify the connection profile. This name
can contain spaces, underscores and numbers. You can save
such Remote Connections for later use using the Save
button.
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Text Box

Description

Host Name

Enter the IP address or full domain name of the FTP server
you wish to connect to. If you enter a name, either you must
either have that name defined in your local hosts table or
your system must be configured to use a Domain Name
System (DNS) server.

Host Type

Select the type of host you are connecting to. If you do not
know the host type, try selecting Autodetect. If the host type
you want is not in the list, or Autodetect does not work, ask
your system administrator to add the host type, see “” later in
this chapter.

Login Name

Enter your login name on the remote host. This must be a
login name that is already defined on the remote host. If you
do not know this, ask the system administrator of the remote
system for your login name and password. Some servers on
the Internet may allow you to log in as Anonymous, with
limited access. If you leave this field blank, Distinct FTP
Client will try to connect as Anonymous.

Password

Enter the password associated with the remote login name. If
you specified the login name “Anonymous”, enter your
complete e-mail address as the password.

Account (Optional) Enter your account ID if your company requires you to
specify this information when making the connection.
Remote Folder
(Optional)

You can connect directly to a specific folder in the remote
file system, if you are authorized to access it, for example,
c:\public\news. Enter the full path (as in the example) or the
path relative to the top level folder that you are authorized to
use. If you leave this field blank, you will be connected at
your top authorized folder. You can move from the initial
folder to others that you are authorized to use during the
session, but you cannot traverse unauthorized folders. This
means that you can access any folders under your top
authorized folder, but not its parent folder.

Capture Control
Enable this option and enter a path only if you need to see a
Port Traffic to Disk trace of the FTP session (please refer to the section “”) or
File (Optional)
add to the recognized hosts in the Host Type list (please
refer to the section “”.)
Port

The well-known port for FTP connections is 21. Some
systems use a different port number for FTP. If you are
trying to connect to a non-standard system, change the port
number in the text box. Most systems do not require
modification of the port number.
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Text Box

Description

Firewall (Optional) A firewall protects your system from the outside world. You
connect to the firewall and it connects to the remote systems.
This means that noone in the outside world can access your
computer directly. You can choose SocksVersion 5 only if
you have a firewall server running this protocol. In this case,
you must define a Server connection profile. Alternatively,
you can choose a passive connection.
Save password
(Optional)

Check Save Password to save the password if you want to. If
Save Password is not checked when you save, no password
will be saved even if you saved it on a previous occasion. It is
more secure to keep a note of the password elsewhere rather
than save it, although Distinct FTP Client does encrypt the
password before saving it.

A connection to a Socks Version 5 firewall server is an active connection that your
system makes using the server information you specify. Distinct currently supports
firewalls requiring a passive connection and firewalls requiring Socks Version 5.
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Text Box

Description

Host Name

The IP address or full domain name of your firewall
server. To enter a name rather than an address, either
your system must be set up to use a Domain Name
System (DNS) server, or the host name must have
been defined during configuration.

Login Name

Your login name on the firewall server. This must be a
login name that is already defined on the firewall
server. Ask the system administrator of the firewall
server for your login name and password.
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Text Box

Description

Password

The password associated with the firewall login name.
Ask the system administrator of the firewall server for
your login name and password.

Port

The well-known port number for firewall servers is
1080. Some systems use a different port number for
the firewall. If necessary, you can change the port
number in the text box. Most systems do not require
modification of the port number.

How to Save Connection and Firewall Profiles
If you want to save a connection profile, you must remember to do so before
making the connection. To save a new or modified connection profile or firewall
profile, click on Save.

How to Delete Connection Profiles
To delete a connection profile, click on Delete.

Multiple Remote Connections
Distinct FTP allows you to have a maximum of 15 concurrent connections. You
can copy files from any remote system to your local system, from any remote
system to another remote system, and from your local system to any remote
system.

Initial Display When Connected
When you establish a connection, the current folder highlighted in the left side
pane changes to the initial folder on the remote system.The file list in the right side
pane changes to show the files in this (remote) folder. The initial remote folder is
the one you specified in the Remote Directory text box when you connected. If
you did not specify a folder, the initial folder is the top folder you are authorized to
use on the remote system. The title bar of Distinct FTP Client shows you the host
name or IP address of the last connection made and the transfer mode in square
brackets.

/

In the left side pane, a remote file system is identified by the
host name or IP address with a drive symbol in pink.

How to Change Folder Using the Mouse
You can change to any displayed folder in the left side of a pane by clicking the left
mouse button on its name. This folder becomes the current folder with its contents
displayed in the right side of the pane. To jump to a folder, even one that is not
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displayed, place the pointer on the correct drive (or any of its folders), click on the
right mouse button, enter the full path for that directory, and click on OK.

How to Disconnect from a Remote Host
To close one of your connections, click on Disconnect in the toolbar (File,
Disconnect). The menu option is only present when you have an open connection.
Select the host IP address or name from the list box, which shows the first
connection made at the top of the list. When you click on the Disconnect button,
the connection is closed and the remote host’s IP address or name disappears from
the left side of the pane.

How to Select and Deselect Groups of Files
The File menu lets you Select All files in a folder, or Deselect All files, which is
useful to undo an unwanted selection. The Invert Select menu option is useful if
you need to select most, but not all, files in a folder. In this case it is quicker to first
select the ones you do not want, and then choose Invert Select on the File menu.
After this, the files you do not want are deselected, and those you want are
selected.

How to View files
Distinct FTP Client allows you to view many different types of file including text,
popular graphics formats and Word Processor files, using the Viewer. To open a
file for viewing:
1 Make sure you are in the correct mode, and if not, click on ASCII or Binary
(Settings, ASCII Transfer or Settings, Binary Transfer) as appropriate for the
file type.
2

Select the file in the file list.

3

Choose View on the File menu. The file is displayed in the pane below the file
tree(s).

How to Download and Upload Files
To download files from a remote folder to a local folder or upload files to a remote
system:
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1

Connect to the remote system from/to which you wish to copy files.

2

Click on a drive or folder to expand the view and see the (sub)folders on this
drive/folder. Click again on a folder name to navigate deeper into your file
system so that you can see the destination folder.

3

Select the name of the folder to which you wish to transfer the files.

4

Check that you have selected the correct transfer mode, please refer to the
section “”.

5

Select the file(s) you want to copy and click on the Download/Upload button
in the toolbar (File, Download File(s) or File, Upload File(s)) or use drag and
drop.

Confirmations
By default, FTP Client protects you from copying the wrong files, and from
overwriting existing files, by asking for confirmation before all operations.

You can choose to work without confirmation by disabling Confirmations using
the Settings menu, see “” later in this chapter.

Transfer Mode
Before transferring files always stop to think whether these files need to be
transferred in binary or ASCII format. To choose the transfer mode, click on
ASCII or Binary in the toolbar (Settings, ASCII Transfer or Settings, Binary
Transfer). On the Settings menu, a check mark will appear next to your selection.
Also, the toolbar button for the currently selected transfer mode will be
unavailable. For more details, please refer to the section “”.

Destination Directory
If you are downloading files to your machine, and you have not selected a
destination folder using the mouse, the Download Selected Files into Local Drive
dialog box displays for you to select a destination folder from the drop-down list
box. The list shows the current working folder on each local drive, which is
determined by the folder that is current for the drive in the upper tree. After
selecting a destination folder, click on Download. The files are copied to the
selected folder.
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If you are uploading files to a remote system, and you have not selected a
destination folder using the mouse, then the Upload Selected Files to a Remote
Host dialog box displays for you to select a host name or IP address from the
drop-down list box. After selecting a destination folder, click on Upload. The files
are copied to the current working folder on the selected remote system.

The Use of Wildcards
If you wish to download or upload a group of files whose names match a certain
pattern, you can use wildcards. A wildcard is a character that means “any
character(s) you like.” The asterisk character (*) is the multiple-character wildcard
and the question mark (?) is the single-character wildcard.

To define a wildcard filter:
1 Choose Options on the View menu. Notice that the Upper Tree page is
displayed initially.
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2

If the filter is for the lower pane, click on the Lower Tree tab. (If you are
working with just one tree, Upper Tree is the appropriate page.)

3

Enable Display Partial and enter the wildcard filter required in the Wildcard(s)
for partial display text box. For example, your entry could read *.doc *.mar. In
this case, when you click on Set, only files whose file name extension is DOC
or MAR will appear in the file list in the right pane.
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/

If you specify multiple wildcard filters in a View Options
property page, they must be separated by one space.
When your file list shows the required files, you can click on the
Download/Upload button in the toolbar (File, Download File(s) or File, Upload
File(s)).

The Selection of Individual Files or Ranges
To transfer individually selected files from a given folder, click on each file that you
wish to copy. You can select a range of files by clicking on the first file, then
holding down the Shift key and clicking on the last file. You can select nonadjacent
files in the same folder by clicking on the first file, then holding down the Ctrl key
and clicking on each additional file. When you have selected files, click on either
the Download button in the toolbar (File, Download File(s)) for copying from
remote to local, or the Upload button in the toolbar (File, Upload File(s)) if you
are copying from local to remote. Or, with all the files that you wish to transfer
selected, keep the mouse button pressed and drag the document-shaped cursor to
the destination folder.

The Transfer Status
For any transfer in progress, the central area of the status bar changes color
gradually to show the proportion of the file or files that has already been copied.
While the transfer is in progress, you may carry on using other applications. The
program window may be minimized or you may bring up other programs on top
of it without disturbing the transmission.

Refreshing File Lists
When you are downloading and uploading files, the contents of the folders
displayed in the Distinct FTP Client main window are likely to change. To refresh
the file list for the current folder in a tree, click on the folder name in the left side
of the window.

How to Copy Files from One Remote System to Another
You can copy files from one remote system to another using drag and drop. Just
click on a file in the right side pane of the window and, holding the left mouse
button down, drag the icon over the destination folder and release the mouse
button. The method is the same as using drag and drop for downloading or
uploading. The only difference is that both the source folder and the destination
folder are on remote drives.
When Distinct FTP Client copies files remote-to-remote, it arranges for one
remote host to be passive if possible. If this is successful, the client copies the files
directly from one host to the other. Should this not be possible, a dialog box
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displays asking if you want the copy to be made anyway, using your system as
intermediary. This will take longer than a direct copy. Click on OK to accept the
indirect method or Cancel to abort the operation.

How to Rename Files or Directories
You can only rename files or folders of which you are the owner. To find out if
you are the Owner on a Unix system, use the command ls -la. Equivalent
commands exist on other systems; if you are unsure of the command, ask your
system adminstrator.
To rename a file or folder, follow these steps:
1 Select the file or folder.
2

Click on the Rename button in the toolbar (File, Rename). The Rename
File/Directory dialog box displays to show you the current name and ask for
the new name.

3

Type the new name in the New Name text box and click on OK.

/

If you get an “Unable to complete rename operation” error
message, check that you have entered a valid new name. Check
also that you are the Owner of the file or folder that you are
trying to rename.

How to Delete Files or Folders
You can delete one or more files from any local or remote folder, within the
limitations of your authorization. You can also delete an empty folder in a similar
way. To delete files, select them and then click on the Delete button in the toolbar
(File, Delete).
To delete an empty folder, select it, and then click on the Delete button in the
toolbar (File, Delete).
It is advisable to have the confirmation option set for Delete, to avoid the
inadvertent deletion of files. This option is set by default. To make sure it is set,
use Confirmations on the Settings menu, please refer to the section “ ” later in this
chapter.
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How to Print Remote or Local Text Files
To print text files that are located on either your local or remote system, select the
files then click on the Print button in the toolbar (File, Print). The print
confirmation dialog box is displayed (if print confirmation is still enabled).

Print Setup
Both the File menu and the Print dialog box give you access to the standard Print
Setup dialog box, so that you can select a different printer.

How to Create Folders
You can create new subfolders on either the local system or any remote system to
which you are connected, within the limitations of your authorization. To create a
subfolder, select the folder that is to contain the new folder and click on the Create
button in the toolbar (File, Create Folder).
The Create New Folder dialog box is displayed, for you to enter the name of the
new subfolder. Type in the new folder name in the New Folder text box, then click
on Create to proceed.

If the “Unable to create subfolder” error message is displayed when you try to
create a subfolder on the remote system, you should check that you are the Owner
of the parent folder and that no subdirectory with the same name exists in the
current folder.
The new folder is initially displayed at the top of the subfolder tree, so that it is
immediately visible, regardless of its name. This allows you to make use of your
new folder without having to scroll the tree. If you fold up and then unfold the
parent folder, the new folder will be in its correct alphabetic position in the
subfolder tree.
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How to Capture Control Port Traffic to a File
This menu option is for trouble shooting and customization only.
You can start to capture the control port traffic for a single connection by choosing
Capture to file on the File menu. Use this facility to make a trace of an FTP session
(please refer to the section “” later in this chapter) or add to the recognized hosts in
the Host Type list (please refer to the section “” later in this chapter).

Settings for File Transfers
The Settings menu allows you to specify the transfer mode for uploading and
downloading, to set which file operations require confirmation, and to select the
font used to display the file trees. The transfer mode is displayed in the title bar of
the FTP Client, to remind you which type of copy will be done.

ASCII or Binary Transfer Mode
You can specify whether you wish to copy in ASCII or binary format. This transfer
mode may need to be reset each time you copy a file if the files you are working on
are of different types. The default transfer mode is ASCII. ASCII mode is for text
files. When you copy a file to a remote host in ASCII mode, all the Carriage
Return (CR) characters, which on your PC are CR + Line Feed (CR LF), are
changed to LF only. When you copy an ASCII file to your PC, Distinct FTP
Client transforms all the LF characters into CR LF.
Set the binary mode for all files that are not plain text files. This mode can copy
correctly any file type. In this mode, no character conversion is done.

/

Files that are generated by word processors or desktop
publishers include formatting information and must therefore
be transferred as binary files.

How to Confirm an Operation
These settings control the requesting of confirmation for file operations.
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You may choose to enable or disable any of the Confirmations. You can decide
whether you wish to be asked to confirm:
• Copying a file
•

Deleting a file

•

Printing a file

•

Overwriting a file on the destination folder that has the same name as the one
being transferred
When you are asked to confirm before overwriting a file, the size and last modified
date of the file are displayed to help you decide. You are also given the choice of
changing the name of the file that is being transferred to avoid overwriting the
existing file.
Distinct suggests that you leave confirmation set for Delete operations and for
overwriting, to avoid the inadvertent loss of files.

Font Choice
By default, the information in the file lists is displayed in the MS Sans Serif
Regular 8 point font.You can change the font by selecting one from the font list in
the drop-down list box. The fonts available are the True Type and other fonts
installed on your system. You can also change the font style to display in italics or
boldface or both, and change the point size to any value that your display supports.

View Items and Options
The View menu allows you to hide the toolbar or status bar or both, in order to
increase the space in the Distinct FTP Client main window, to disable column
headers in the file lists, and to change the information displayed for each file in a
list.
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Toolbar and Status Bar
You can disable the toolbar and status bar if you wish to have more main window
space for the file trees. To disable/enable the display of these items, click on them
in the View menu. When display is enabled (as it is by default), a check mark
appears to the left of the item in the menu.

Options
You can set different View options for the upper tree and lower tree when you
have two folder tree windows (Window, Two Trees enabled). Use the Upper and
Lower tabs to move to the property page for the upper tree and lower tree
respectively. If you have only one folder tree available (Window, One Tree
enabled), then set options for this tree as upper tree options. Any lower tree
options you set at this time will apply to the lower tree if you subsequently enable
two trees.
You can choose to see Short or Long format file information in your file lists. The
short format lists only filenames; the long format lists the file name, size, date and
time of creation or last modification, and the file attributes (for local files) or
authorization access rights (UNIX files). You can disable the file list column
headers (Name, Size, Modified On, and Attributes) for the upper and lower file
lists. To disable/enable the display of the headers, click on Column Headers. When
display is enabled (as it is by default), a check mark appears to the left of the item.
It is possible to display All the files in a given folder or to get a Partial view of the
folder contents by displaying only those files whose names match certain patterns.
In this case you need to enter the required wildcard pattern(s) in the Wildcard(s)
for partial display text box.

For example if you wish to view only those files with names that start with the
letters “f_” and extensions that start with “p”, you would enter:
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f_*.p*

You can choose to display local file and folder names in lower case by checking
Lower case display (Local).

How to Use the Window Menu
The Window menu allows you to work on a command line, to switch between one
file tree and two file trees, and to display either a network trace or file contents in a
window pane below the file tree(s).
In the 32-bit version of Distinct FTP client, the title bar tells you if you have a tree
view or a command line view.

Command Line
If you want to work with a command line FTP interface, select this option. The
command line window takes the place of the file tree(s) (and the network trace if
this is displayed). The menu options available also change. In command line mode,
you have no toolbar, and you have the following menu options: File, Abort (while
an operation is in progress); File, Exit; Options, ASCII Transfer; Options, Binary
Transfer; Options, End Command Line; Help, About...; Help, Index.
To see which FTP commands are available, enter help at the command line
prompt. The following shows an example of the output, but always check the latest
information.
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To revert to using folder trees and file lists, choose End Command Line on the
Options menu.
You can exit directly from Distinct FTP Client when you are in command line
mode by choosing Exit on the File menu.

One or Two Trees
You can choose to display either one folder tree and file list or two, one above the
other. The two tree option allows you to look at two drives or folders
independently, for example, one on your local system and one on a remote system.
Working with two trees is much the same as working with one; you just click on a
folder to select it as current. With two trees displayed, you can drag files from one
tree and drop them on the other, to transfer files to the currently open folder of the
destination tree.

How to take a Network trace
If Network Trace is enabled, File Contents Viewer cannot be.
The network trace is for use when you need to trouble shoot a connection. It starts
to display the control port traffic for all active connections when you enable it. This
gives you an on-line display of control information rather than a record of it in a
file, which you can obtain using the Capture to file option on the File menu or on
the Connect to Host dialog box. The network trace includes control information
for all active connections, whereas a capture option limits the scope to one
connection.
Control port information comprises the FTP commands you send to other systems
and their responses. It does not include any file content. The following is an
example of control port traffic.
USER shirley 331
Password required for shirley PASS distinct 230
User shirley logged in.
ACCT 502 ACCT command not implemented.
PWD 257 “/home/shirley” is current folder.
CDUP 250 CWD command successful.
PWD 257 “/home” is current folder.
CWD ./shirley 250 CWD command successful.
PWD 257 “/home/shirley” is current folder.
PORT 126,121,132,103,4,84 200 PORT command successful.
LIST . 150 ASCII data connection for /bin/ls (195.201.117.13,1008) (0 bytes).
226 ASCII Transfer complete. total 11 -rw-r—r— 1 shirley staff
2897Mar 12 10:47.cshrc -rw-r—r— 1 shirley staff
2496Mar 12 10:47.login -rw-r—r— 1 shirley staff
2750Mar 12 10:47.rootmenu -rw-r—r— 1 shirley staff
478Mar 12 10:47.sunview drwxrwxrwx 2 shirley staff
512 Mar 12 11:05 test 313 bytes transferred in 0.055 seconds (5 kBytes/sec)
QUIT 221 Goodbye.
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By studying a network trace you can see what is causing a connection failure or
some other problem.

File Contents Viewer
If File Contents Viewer is enabled, Network Trace cannot be.
The viewer facility allows you to view local and remote files containing either text
or image data. The file contents are displayed in a separate pane below the file
trees.

/

Some file types may not be supported.
When the viewer is enabled, you can view a file by selecting it and choosing Open
on the File menu. Please refer to on page 7-12 for details.

Adding FTP Templates
The format of folder and file information transmitted using FTP varies from
system to system. This information is used by the Distinct FTP Client to build the
folder trees and file lists it displays. The Distinct FTP Client recognizes the formats
transmitted by the FTP servers on many common types of system and can
therefore display the file information for those systems correctly. If you connect to
a host that is running an unrecognized FTP server, the file lists displayed may seem
strange or incomplete.
All FTP server types recognized by the Distinct FTP Client appear in the Host
Type drop-down list box on the Connect to Host dialog box.
You can add to the recognized host types if necessary. For each host type you add,
you must define a template in the Registry. A template is a pattern that tells the
Distinct FTP Client how to interpret the file information transmitted by a given
type of FTP Server.
To define a template, two steps are necessary:
1 To record the file information transmitted, choose Capture to File on the File
menu, or check Capture Control Port Traffic to Disk File and enter a filename
on the Connect to Host dialog box.
2

Use the order of fields in the file information to define a template, and add it
to the Registry using regedit.

How to Capture Control Port Traffic
If you are already connected to a host, you can start to capture the control port
traffic at any time by choosing Capture to file... on the File menu and specifying a
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disk file name. Alternatively, you can do this while making a connection, by
following these steps:
1 Choose Connect on the File menu to see the Connect to Host dialog box, if
this is not currently displayed.
2

Enter a valid login name and password, and an account (if required). You do
not need to select a host type since the correct one is not listed yet.

3

Check the Capture control port traffic to disk file checkbox.

4

In the associated text box, enter a path to use as the destination file for the
control information. The file does not have to exist already.

5

Click on Connect. In the main window, you will notice that the connection
has been made, but the file list information is probably incorrect. Once you
create an appropriate template, files will be listed correctly.

6

From another program, such as Notepad, open the destination file you have
created. Within this file, you will see the control port traffic, including folder
and file information.

How to Create a Template
A template specifies the contents of the fields in a control line concerning a file or
folder, sent by a host that is running an FTP server of a given type.

Example of Template for Windows NT
The template for the Windows NT host type is:
\WinNT=%2d %s %n
This tells the FTP Client:
• The path separator is backslash (\).
•

There are two date/time fields, followed by:

•

The file size field. This field is followed by:

• The file or folder name field.
There is no permission data.
The following lines show some file and folder information received from a
Windows NT workstation in this format:
01-19-94 06:26PM
03-08-93 01:39PM
02-20-93 10:34AM
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03-03-93 08:29PM
09-14-93 12:13PM

70002 GCP.HLP
283043 GCP.ZIP

Since Windows NT has similar file and folder information to DOS, any folders will
have the string <DIR> instead of the file size. This allows Distinct FTP Client to
recognize a folder or subfolder.
The Distinct FTP Client uses the Windows NT template to interpret the
transmitted information, and will display the folder and file list for folder GCP
(with long format and lower case local display) as follows:

How to Add a Template Definition
The template definition must go into the Registry. To add a template definition,
follow these steps:
1 Click on Start and Run regedit.
2

Find the HKEY_LOCAL_MACHINE\SOFTWARE\Distinct\APPS\FTP32
key and open it.

3

Use Edit, New, String Value to add an entry with Value name Templates, and
type in your host type name, an equal sign, and the pattern of file information
fields as its Value data.

4

Quit the Registry.

If necessary, you can later select the Templates entry and use Edit, Modify to
change the Value data.
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Template Definition Rules
•

A template definition must be on one line, and must comprise a host type
name set equal to the pattern of file information transmitted, preceded by an
optional path separator character.

•

The path separator character can be any single character. The default value if
no path separator is present is slash (/), as in Unix.

•

Host type names are arbitrary and can contain spaces, but they must be
different from any host type already included in the Host Type list box on the
Connect to Host dialog box.

•

The pattern can include any number of elements made up as follows:
%[1...9]p | d | s | n | i

where each letter refers to a specific file information field as explained in the
following table.
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Field Code

Field Name

Description

%p

Permission

Who can use a file or folder and how
they can use it. There are three possible
permissions: read, write, and execute,
for three sets of people: owner, group
and world, (for example -rw-r—r—).

%d

Date or Time

The date or time or both (for example
Sep 14 11:40). Usually there is more
than one date/time field as spaces
within information mean separate
fields.

%s

Size

The file size in bytes.

%n

Name

The filename (for example
STATS.ZIP).

%i

Ignore

Remote system information that
Distinct FTP Client does not display
(for example user name, department).
Such fields are ignored.

•

Fields can be separated by spaces or tabs or both; no spaces are allowed within
a field.

•

Each letter (p, d, s, n, i) must be preceded by the percent sign (%) which may
be followed by an optional repeat count from 1 to 9. The repeat count
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indicates how many times the field appears. This number is normally used for
date and time fields, or for fields to be ignored.
•

You can put the same field more than once. For instance, %d %i %d and %2d
both specify two date/time fields, such as 01-08-93 and 06:12PM. In the first
case, the date/time fields have unwanted information between them.

•

After the fields, you can put up to 3 “exclude strings”. An exclude string is a
string preceded by a comma. Any line from the remote host that starts with
the string (leading spaces are skipped) will not be used by Distinct FTP Client
when it builds the folder tree and file list.
Exclude strings are most commonly used to exclude summary information.
For example, the template below tells Distinct FTP Client that when it is
connected to a Microware OS/9 host type, any line beginning with Owner or
3 dashes should be ignored.
Microware OS/9= %i %2d %p %i %s %n,Owner,———-

•

For a host type with UNIX-style file and folder information, do not specify the
letter d as an exclude string ( “,d”). You risk excluding all lines relating to
folders and subdirectories.

How Folders are Recognized
There is no template field to indicate subdirectories. Distinct FTP Client
recognizes folders automatically if they use the UNIX or DOS standard structure
for folder information, as explained in the following table.
Control Information

Field

Directory Recognition

UNIX-like

Permission (%p)

Starts with d

DOS-like

Size (%s)

<DIR> instead of number

/

For UNIX, you must include a permission field (%p), and for
DOS, you must include a size field (%s). Otherwise, all folders
and subfolders will be listed as files.

Trouble Shooting
If you have problems connecting to a host, you should check that the host name or
IP address is correct, and also verify your account details. If you want to connect
using a host name rather than an IP address, your local host table must include the
host name definition.
If these details are correct, but you still cannot connect, check that the gateways for
your system are correctly defined in your TCP/IP configuration and try to Ping the
remote system to see if it is reachable.
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If you need to analyse what is happening more closely, you can capture the control port
traffic in a file or as a network trace, please refer to the section “”.
If you cannot view a file using the View option on the File menu, it may be because the file
type is unsupported, or because the mode (ASCII/Binary) is not set correctly.
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Distinct Line Printer Daemon (LPD)

Distinct LPD turns a Windows based PC into a print server providing
print services for users on a TCP/IP-based network. Furthermore, users and
application programs on PCs running the Distinct Network File System
(NFS) client can print files through a Distinct LPD print server, thanks to
the interworking of Distinct LPD and Distinct NFS servers. UNIX
workstation users on an appropriately configured system can print through
a Distinct LPD print server by means of the UNIX lpr command.
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How to Start Distinct LPD
To start Distinct LPD, click on its icon on the desktop or in the Distinct Toolbar.
When you start to use Distinct LPD, you will need to perform the following tasks:
1 Plan your print servers, as described in the section ““.
2

Set an administrator password if password security is required. For more
information on setting the administrator password refer to Chapter 1 in this
manual.

3

Define a spool folder as described in the section “How to Define a Spool
Folder”.

4

Define physical and logical printers that network users will be allowed to print
to.

5

Define user access rights for each logical printer through the Security property
page.

6

Define printer control information and a log file.

Items 3 through 6 are configuration tasks which will need to be performed on all
machines that will operate as print servers on your network. If an administrator
password is set, then you must log in as administrator before you can perform
configuration tasks. For details of administrator password definition and login,
please refer to the section “How to Set the Administrator Password After
Installation" in Chapter 1 of this manual. For details of how to configure Distinct
LPD, please refer to the section “How to Configure Distinct LPD ”.

/

When you start Distinct LPD for the first time on a system
where no spool folder has been defined you are asked to define
this now.
When you start Distinct LPD for the first time on a system
where no printers are set up for remote access, a message is
displayed to remind you about setting up printers. If you say
Yes to this message, it takes you directly to the Configure LPD
property pages.

Overview
Distinct LPD has a main window that displays a printer selection list, print
statistics and a job list. This allows you to keep track of total print activity and the
print jobs pending in each print queue. The main window also has a toolbar for
quick access to common operations, and a status bar to give useful transitory
information.
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Monitoring the Print Queue and Statistics
The display in the LPD main window shows the total numbers of files and bytes
printed, split by ASCII (text) and formatted (for example, PostScript or word
processor files). You can see at a glance the general picture of print activities on
your network. Statistics are cumulative and only get reset when you press the Reset
Statistics button.
By choosing a Printer Logical Name from the drop down list box, you can check a
specific printer queue’s printing and spooling status, and monitor the jobs in the
queue. To do this select the job whose status you wish to modify and right-click
the mouse button to choose from the options available.

Menu Bar
The menu bar gives access to all the LPD functions, and shows the shortcut keys
available for some menu options.

Toolbar
The toolbar is located below the menu bar, with easy to read buttons for you to
click on. Position the pointer on a button to see a brief description of its function.
The toolbar can be docked on any of the four program window sides or it can be
left as a floating toolbar. The following summarizes the toolbar:
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The Login button allows you to log in as administrator when
password security is in force (Configure, Administrator, Login).
The Logout button allows you to log out after an administrator
login (Configure, Administrator, Logout).
The Configure Server button allows you to configure Distinct LPD
on your print server (Configure, Server).
The Reset Statistics button resets all the statistics counters to zero
(View, Reset Statistics).
The Help button gives access to Distinct LPD help topics (Help).

Status Bar
The status bar shows you the function of a toolbar button or menu option as you
point to it.

How to Exit
If an administrator password is set, you can only exit Distinct LPD when you are
logged in as administrator. This protects users from unauthorized shutdown of a
print server. To exit Distinct LPD, choose Exit on the Configure menu.
If there is an active print job, or users have print jobs pending, Distinct LPD will
ask you to confirm the exit request.

Planning your Print Server Deployment
When planning your LPD print servers you will need to take a number of factors
into account including the total number of users, the average print volume of each
user, the number of physical printers available to you and the number of
computers that can be set up to be LPD servers. Read the following paragraphs to
help you gather all the information you will need before setting up and configuring
your Distinct LPD servers.

Print Servers
Distinct LPD can be installed and configured on any PC in the network, but the
user(s) of the machine should be warned of this to avoid inadvertent shutdowns.
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Also, the users on a print server should leave sufficient disk space for print
spooling. There are no rules regarding minimum disk space, but you should
consider the type of printing that will be done and the number of jobs that are
likely to be spooled at any one time. For example, more space is required for the
spool directory on a print server used by graphics designers than on one used for
printing small text files. If disk space is lacking when a print job is submitted,
Distinct LPD displays a message and refuses the print job while on the client side,
the user’s print request fails.
When selecting the machines that will act as the LPD servers you need to take a
few things into consideration:
• Choose those computers that have the least work load and avoid those that are
being used for very memory-intensive jobs.
•

Only choose computers where the user is familiar with common computing
practices and which are not using software packages that tend to crash the
system frequently.

•

Make sure that the computers chosen have adequate disk space on the drive
containing the spool folder.
The machines chosen may need occasional management and maintenance for LPD
purposes. As Distinct LPD runs in the background, a print server remains available
for other work.

Printer Servers
LPD printer servers allow controlled printing by users across a TCP/IP LAN or
WAN. When choosing the printers to be used, remember that they need to be
physically accessible for users to collect their jobs. You can define one or more
logical names for each printer. If you try to configure for LPD a printer that is not
yet defined in the Control Panel, Distinct LPD allows you first to define the
printer and then to configure it. Distinct LPD also allows you to modify a printer
configuration while the server is running, but you should make sure that the
printer is not in use and that you disable printing and spooling before attempting
any modification.

How to Define the Spool Folder
Each printer can print only one file at a time, and so Distinct LPD stores the files
submitted for printing. The files are stored as print spool files in a spool folder.
Distinct LPD requires you to define a general spool folder on each print server,
within which it creates a spool folder for each printer logical name configured.
Later, you can redefine the spool folder, but you should make sure the print queue
is not in use and disable printing and spooling before making such a change.
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Printer Access Rights
When a print server is first configured, it can be accessed by all users who have
network access and know the printer logical name. You may wish to limit access by
defining a security profile which authorizes only a few machines on the network to
use a particular printer . Access to a print server may be limited to a specific
network, a subnet or simply to specific machines or to a mixture of all three. The
priority of print jobs that each authorized machine can submit can be defined by
the LPD administrator, for example, machine A can be authorized to submit only
Low priority jobs, while all jobs submitted by machine B will be given high
priority.

Control Information
When different print queues are defined for the same printer, or in other
circumstances, it can be useful for control information to be sent to the printer
either before each print job, or after each print job or both. Control codes can be
used for various purposes:
• To switch printer modes, for example, from PostScript to text
•

To initialize printer settings

•

To download fonts

•

To print banner pages, for example, signaling the user name and job number.
(First print the information to a disk file and then specify this file as the
control file.)
You can define control information for each printer profile separately.

How to Configure Distinct LPD
The first time you start Distinct LPD, the Printers, Security, and Control
Information databases are all empty. If you have already planned your print
servers, you should be able to enter all the configuration information needed to
make the server operational. Later, you can modify your LPD configuration to add
or remove printers, authorize new IP addresses, and change control information. If
an administrator password has been set, you must login as administrator before
you can make any configuration changes.

How to Configure Printers
You must configure printers using the Add printer wizard in the Control Panel
before they can be accessed through LPD, and before you restrict access to them if
necessary. When configuring the printer for LPD, you must specify at least one
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unique logical name and associated profile for each physical printer. You can define
more than one logical printer for the same physical printer, for example, to
implement a PostScript print queue and a text print queue on the same printer. (In
this case, you would need to define control information to switch printer modes).
Later you can remove unwanted printer profiles and add new ones.

How to Add Printer Profiles
To add printer profiles to the LPD Printers database, follow these steps:
1 The first time you run Distinct LPD you are asked if you want to configure
your printers, choose Yes. To configure printers later, click on the Configure
Server button in the toolbar (Configure, Server). The Printers property page is
displayed.
2

Select a Printer Name. The Printer Name box lists all printers that have been
added in the Control Panel of your PC. If the printer you want to configure is
not present, you can click on Setup to go to the Add Printer Wizard and install
it. Make sure that you choose to setup the printer as a Local printer. At the
end of the setup sequence, you can close the Printers window and configure
the printer for LPD in the Printers property page.

+
3

Enter a Logical Name for the printer. The Logical Name may be up to 16
characters long and may only contain alphanumeric characters.

/

4

You should only add printers that are local. It is possible to bridge
networks using Distinct LPD and add a printer that is on a
different network, such as Novell NetWare, but this requires
caution and, in general, Distinct does not recommend this.

A logical printer name cannot be modified. You can remove a
logical printer and add a new one if necessary.

Click on Add.
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When a printer is first added, the Printing and Spooling options are enabled so
that the printer is ready for immediate use. Unless you experience technical
difficulties, printing and spooling should remain enabled at all times. For details of
how and when to disable these options, please refer to the section “”. The printer is
available to all network users who know its logical name unless you restrict that
access through the Security property page.
You can continue to add printers by repeating steps 2 to 4. When you have
finished, click on Apply if you are going to define access rights for these printers
and then click on the Security property page, otherwise, click on OK to close the
property pages.

How to Modify the Status of a Printer
To modify a printer profile, follow these steps:
1

Click on the Configure Server button in the toolbar (Configure, Server). The
Printers property page is displayed initially.

2

Select the printer logical name in the Current Connections list.

3

Click on the Enable Printing or Enable Spooling to change the status.

4

Click on Modify and then on OK to close the property pages.

How to Remove a Logical Printer
To remove a printer, follow these steps:
1 Click on the Configure Server button in the toolbar (Configure, Server). The
Printers property page is displayed.
2

Select the printer logical name in the Current Connections list.

3

Click on Remove.
A message is displayed informing you that any job printing will be aborted and
any pending print jobs already spooled will be deleted.

4

Click on OK to continue and then on OK to close the property pages.
Distinct LPD deletes the spool folder for the printer once it is empty.

How to Restrict User Access Rights to Printers
Once you have configured one or more logical printers, you can specify what
access rights users will have to these printers. If you do not specify a security
profile for a logical printer, LPD will allow all network users to print to it. In this
case, the default security profile comprising a single *.*.*.* address entry with
Low priority access applies. If you later decide to restrict access to the print queue,
you must remove this global address entry. If you leave this entry and add others,
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then other machines may have higher priorities but all machines will continue to
have access to the print queue.

How to Modify User Access Rights
To add a machine or set of machines to a security profile, follow these steps:
1 Click on the Configure Server button in the toolbar (Configure, Server).
2

Click on the Security tab.

3

Select the Logical Name of the printer you wish to modify access rights for.

4

Enter an IP address. This can be a wildcarded expression representing several
machines, for example, 128.42.200.*.

5

Click on the required priority level.
You can give a set of machines a lower priority level, and specific machines
within the set a higher priority level. For example, subnet 128.41.200.* can
have medium priority and machine 128.41.200.10 on this subnet can have
high priority.
If a machine has high priority access, this means that any print jobs from that
machine are printed before any medium or low priority print jobs. Similarly,
medium priority print jobs are printed before low priority ones. Jobs at the
same level of priority are printed in order of arrival.

6

Click on Add.

7

When you have finished adding the networks or machines you wish to give
access to this printer, click on OK to continue.

+

If you wish to remove world access to a printer make sure you
remove the *.*.*.* entry from the list.
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How to Modify Priority Rights
To modify one of the entries in a security profile, follow these steps:
1 Click on the Configure Server button in the toolbar (Configure, Server).
2

Click on the Security tab.

3

Select the Logical Name of the printer whose security profile you want to
modify.

4

To see the existing priority for the address in an entry, select the entry. To
change the priority, click on the required Priority button.

5

Click on Modify and then on OK to close the property pages.

How to Remove an Entry from the Access List
To remove an entry follow these steps:
1 Click on the Configure Server button in the toolbar (Configure, Server).
2

Click on the Security tab.

3

Select the Logical Name of the print queue for which you want to remove an
entry.

4

Select the entry in the list.

5

Click on Remove to remove the entry, and then on OK to close the property
pages.

How to Define Control Information for a Printer
To define control information, follow these steps:
1 Click on the Configure Server button in the toolbar (Configure, Server).
2
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Click on the Control Information tab to display the Control Information
property page.
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3

Select the Logical Name of the print queue for which you want to define
control information.

4

Check the before or after box or both.

5

For both before and after information, you can specify a file containing control
and other characters or enter the characters directly in the String text box.
Click on either File or String as appropriate.

6

Click on Modify when you have finished entering all the data.

You can continue defining control information for print queues by repeating steps
3 to 6. When you have finished, click on OK to close the property pages.

Logging Print Activity
To log printer activity, you need to define a folder for the log files. Log files
provide a record of all print activities and show the most frequent users and the
most heavily used printers. This can help you in allocating users to printers to
avoid bottlenecks.
To define a log file folder, follow these steps:
1 Click on the Configure Server button in the toolbar (Configure, Server) .
2

Click on the General tab to display the General property page.

3

Enter the complete folder path or use the Browse facility to select a folder.

The log files maintain a history of all print jobs sent to the server. Every day a new
log file is created using the current date as the filename and the extension .lpd (for
example, 092197.lpd for a log file created on September 21 1997).
Following is an example of a log file’s contents:
HP, 000, jim, 128.41.200.12, 10:12:25, 7646, Job Spooled
HP, 001, fred, 128.41.200.10, 10:12:25, 16916, Job Spooled
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HP, 000, fred, 128.41.200.10, 10:12:26, 7646, Started Printing
HP, 000, fred, 128.41.200.10, 10:12:29, 7646, Finished Printing
APPLE, 000, kathy, 128.41.200.11, 10:16:20, 30462, Job Spooled
APPLE, 000, kathy, 128.41.200.11, 10:16:20, 30462, Started Printing
APPLE, 000, kathy, 128.41.200.11, 10:16:20, 30462, Finished Printing
HP, 000, jim, 128.41.200.12, 10:16:22, 7646, Job Deleted
The first entry in each line is the logical printer name and the next entry is the job
number. Jobs are numbered separately in each print queue. This is followed by the
user name and the IP address of the machine. Next is the time, the file size in bytes
and the print status. The possible print status values are: Job Spooled, Started
Printing, Finished Printing, Job Deleted.
To activate/disactivate logging, enable/disable Logging on the Options menu.
When the option is checked, it is enabled.

/

Remember to manually delete or archive old log files regularly.

How to Enable/Disable Prompt Dialogs
To enable or disable the possible prompt dialogs, follow these steps:
1 Click on the Configure Server button in the toolbar (Configure, Server) and
then click on the General tab to display the General property page.

2

Check the required prompts.

3

Click on OK to close the property pages.

The prompt dialogs cause messages to be displayed when you have no
administrator password set, when you have no spool folder set, or when you exit
Distinct LPD. Initially these dialogs are all enabled.
The messages serve as reminders or for security purposes. The Set Administrator
Password prompt becomes unavailable when an administrator password has been
set. The Spool Folder prompt becomes unavailable when you have defined a spool
folder. The Exit prompt is available at all times.
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How to Define the Spool Folder
The first time you run Distinct LPD, you are prompted to define a spool folder.
Distinct LPD cannot be made operational until you specify a new or existing folder
as your main spool folder. If you do not define a spool folder when prompted, you
can do so later by choosing Spool Folder on the Configure menu.

Enter the complete path of your spool folder or use the Browse facility to select a
folder. If the folder does not exist, Distinct LPD prompts you to confirm its
creation.
If you enter only a name, the folder is created in the current working folder (where
Distinct LPD is installed.)
Distinct LPD creates a spooling folder for each printer configured under the
overall folder. These folders contain the spool files for pending print jobs. If you
remove a printer profile, Distinct LPD deletes any spool files in the printer’s folder
and then deletes the folder.

How to Add New Printers
If you need to add a newly connected printer, you can do so from within Distinct
LPD, and then configure the printer for LPD. The New Printer option on the
Configure menu takes you to the printer setup sequence in the same way as if you
had added a printer from the Control Panel of your PC. It is also possible to access
this setup sequence from the Printers property page of the server by means of the
Setup button.
The basic printer definition includes the printer driver, the port, and the default
printer setting. You will need the appropriate operating system disk if the new
printer requires a printer driver that is not installed. For full details of printer
setup, please refer to the operating system documentation.
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How to Use Your LPD Environment
For the print server to be active for users, you must start Distinct LPD. If you
intend to use the print server as a client of other programs, or for other office
work, remember to leave the LPD program running as an icon. If Distinct LPD is
not running, remote users will not be able to print to printers under its control.
While Distinct LPD is running, you can monitor the printers under its control and
check on the print statistics displayed in the main window. You can manage jobs in
the print queues by changing priorities and canceling jobs.
Jobs in a print queue are listed in the order in which they were received, and not
according to their priority. They are therefore executed in a different order from
the display order.

View Items, Statistics and Log
Distinct LPD has a View menu for you to customize the LPD main window
display.
The View menu allows you to hide the toolbar or status bar or both in order to
increase the space in the Distinct LPD main window, to reset the statistics display
in the main window, and to view a log file in a separate window.

Toolbar and Status Bar
To enable or disable the toolbar or status bar, click on its name in the menu. A
check mark next to a name means that the item is enabled.

Reset
Choose Reset Statistics to reset the print totals to zero.

Log File
You can view the contents of a log file for a particular day by choosing Log File on
the View menu. The standard Open dialog box is displayed.
Use the Browse facility to locate the required log file. Log file names reflect the
day’s date, and they are located in the log file folder specified in the General
property page of the Server configuration. For further details, please refer to the
section “ ”.

Options for LPD Operation
Distinct LPD has an Options menu for you to control the way the print server is
operating at a particular point in time.
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The Options menu allows you enable and disable logging, printing and spooling,
reset the priority of jobs in a queue, and cancel jobs.

Logging
Logging provides a day by day record of print activities. The log files are located in
the log file folder specified in the General property page of the server
configuration. To enable or disable logging, click on its name in the menu. A check
mark next to a name means that the item is enabled.

Spooling allows users or application programs to transparently print local files or
network files through an LPD print server even when the selected printer is busy.
The spool files are located in the spool folder on the print server that was specified
using the Spool Folder menu option on the Configure menu. A user or application
program on a client system only needs to know an appropriate printer logical
name. To enable or disable printing or spooling, choose the printer name from the
Logical Printer drop down list box, then click on the command you wish to disable
in the Options menu. A check mark next to a name means that the item is enabled.
You should disable printing if there is a problem with the printer, for example, a
paper jam, or if you need to redefine the spool folder or change the printer setup.
You should disable spooling if you need to redefine the spool folder or if there will
be a delay over a printer problem or configuration change. When spooling is
disabled, Distinct LPD does not accept print jobs, while on the client side, users’
print requests fail.

+

If printing is disabled but spooling is enabled, all print jobs will be
spooled. If the drive containing the spool file becomes full, a
message warning you that this has happened is displayed.

Changing Job Priorities
You can change the priority of jobs one at a time only. To change the priority of a
job in a displayed queue, follow these steps:
1

Select a job in the list.

2

Choose Priority on the Options menu or right click the mouse button in the
queue area, then choose the required priority level on the submenu.

/

Once a job has started to print (status Started Printing), you
can no longer change its priority.
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Canceling Jobs
You can cancel print jobs one at a time only. To cancel a job in a displayed queue,
follow these steps:
1 Select a job in the list.
2

Choose Cancel Job on the Options menu or right click the mouse button and
choose Cancel Job.

The Sending of Print Jobs to a Distinct LPD Server
Clients of a Distinct LPD print server may be other PCs with Distinct LPR or the
Distinct Network Printing capability, UNIX workstations (once UNIX has been
suitably configured), or other machines with compatible client programs.

Distinct Network Printing and LPR
Distinct Network Printing and LPR allow users to print any printable local file
through LPD. For further details, please refer to the Distinct NFS User’s Guide.

/

If you install Distinct Network Printing or LPR and Distinct
LPD on the same PC, make sure that you do not set up a
network driver on a parallel port to which you have connected
a printer for use through LPD.

Distinct Network Printing
Distinct Network Printing displays a list of the printer logical names available on a
print server machine (identified by its IP address) and allows the user to select one.
For further details, please refer to the Distinct NFS User’s Guide.

The UNIX lpr Command
To print to an LPD print server from UNIX, the user must know a printer logical
name and enter the correct print command. The following shows the typical LPR
command syntax on a UNIX system:
lpr -Pprintername -h [-c | -p] filename

where:
printername is the logical name of the printer as defined in Distinct LPD
-h means that no header will be sent
-p means that page numbers are to be printed
-c means that page numbers are not to be printed
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+

If neither -p nor -c is specified, Distinct LPD will not format the files into
print pages.
Check your operating system manual for the exact syntax. It may vary from
system to system.

Print Setup for Distinct LPD in UNIX
Before UNIX users can send print jobs to a Distinct LPD print server, the UNIX system
administrator must add an entry in the PRINTCAP file. The following is an example of
such an entry:
# Printer on PC in marketing group, access for marketing only
hp1 :lp=:rm=PCLPD:rp=quality:sd=\usr\spool\quality
where:
hp1 is the logical name of the printer
PCLPD is the name of the machine where Distinct LPD is running
quality is the logical name to which UNIX users will print
\usr\spool\quality\ is the local spool directory in UNIX.

Local Users
The local user on a print server can print directly to a local printer used by LPD. Non-LPD
use of a printer by a local user will make the printer temporarily unavailable to Distinct
LPD. In this case, no message is displayed. Distinct LPD retries the printer at intervals.

How to Prepare your AS400 to Print to Distinct LPD
To configure your AS400 to use LPR, you need to create a common output queue with IP
as the protocol. Configured this way the AS400 will use LPR to send the report to the
printer. You also need to define the host name of the PC running Distinct LPD in the
AS400 host file.

+

Certain AS400 operating system levels appear to have a problem using the
IP address. If your system appears to have this problem use the host name
instead.
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A
EHLLAPI, WinHLLAPI

Distinct IntelliTerm supports the EHLLAPI, HLLAPI, and WinHLLAPI
standard interface mechanisms. These interfaces allow other Windows
programs to communicate and control the TN3270 emulator. The
WinHLLAPI.DLL (WHLLAPI.DLL) is compliant with the WinHLLAPI
specifications as set in Microsoft’s Windows Open Services Architecture.
WinHLLAPI is supported in Distinct IntelliTerm. The appropriate DLL
must be in your path so that it can be loaded by Windows when you run
your client application. The EHLLAPI and WinHLLAPI APIs are
documented in the Distinct IntelliTerm Toolkit.

Distinct IntelliTerm
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Dynamic Data Exchange (DDE)

Dynamic Data Exchange, commonly referred to as DDE, is used for
inter-process communications. It allows programs such as Excel, Word for
Windows, and Visual Basic to interface with the 3270 emulator. With the
DDE interface, you can create new terminal sessions, enter data, retrieve
screens, transfer files, and even run macros.
Unlike the EHLLAPI interface which is a low-level programmatic interface
typically from C or C++, the DDE interface in Distinct IntelliTerm is
designed to be used from high level languages such as Visual Basic or Word
Basic. For example, with the DDE interface you can write macros in Word
for Windows to log you into the host, transfer a file to the host, and then
automatically send mail.

Distinct IntelliTerm

How DDE Works
DDE transfers information in conversations. A conversation is carried out between
a client application and a server application. Distinct IntelliTerm is a server
application.
When Distinct IntelliTerm is loaded, it broadcasts to DDE that its services are
available. Then a client application such as Word for Windows can initiate a
conversation with Distinct IntelliTerm. You can compare a conversation to a
telephone call. You must call your friend in order to have a conversation. Once a
conversation is established, the client application can request information, run
macros, press keys and even transfer files.
There are four main types of DDE messages that can be issued from a client
application: a Request message, a Poke message, an Execute message, and an Advise
message. The Request message is used to get information back from the server
application. For example, you would request a copy of the screen, known as the
Presentation Space. You would use a Post message to press keys, move the cursor,
or copy a block of data directly into the presentation space. Execute messages are
used to execute session or system commands. You use execute messages to transfer
files, run macros, and open new terminal sessions. The Advise message is used to
create warm or hot links with the emulator. This message is used to have the host
inform your client application when certain events occur.
There are two necessary fields used in all DDE conversations: the application
name and the topic. The application name directs the DDE conversation to a
particular application. The application name for Distinct IntelliTerm is iterm. The
topic specifies the terminal session which is the session short name assigned in the
session profile. It is always a single letter usually starting with ‘A’. There is a special
topic called System which allows you to perform non-session oriented functions.
A third and highly used field is the item. The item usually specifies the request or
command issued to the session or system.

Terminology
The following terms and values are important for most aspects of using the DDE
interface.
The screen is commonly referred to as the Presentation Space or PS. When
copying information to/from the PS, the indices used always begin at 1 and end at
the last value of the PS. For example, a 24x80 screen has 1920 addressable
positions which range from 1 to 1920.
Some of the requests return multiple items back to you in a single string. Each
item is delimited using the carriage return byte (‘\r’ in standard C syntax) value
0x0D or 13 decimal.
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Starting a Conversation
To start a conversation with Distinct IntelliTerm, you must send an INITIATE
message with iterm as the application name and a topic which can be one of the
session short names or System.

Visual Basic for Applications (Word for Windows, Excel)
To start a conversation in Word for Windows or Excel’s VBA, use the following
syntax in a macro:
iChanNum = DDEInitiate( “ITERM”, “A” )
The topic “A” can be replaced with any other existing session short name or
“System” to access the system topic.

Microsoft Excel 4.0
To start a conversation in Microsoft Excel 4.0, use the following syntax in a cell:
=INITIATE( “ITERM”, “A” )

System Topic
The System topic is very useful to find out information about the system. For
example, it allows you to see what sessions are currently in use. The System topic
supports the following items which can be requested using the Request command:
Command

Description

SysItems

Returns a list of available items that can by queried
for
the System Topic. Each item is delimited using a
carriage return ”\r”.

Topics

Returns a list of available topics that can be used in
conversations. The list always includes the System
topic and the session short names of connected
sessions. Each item is delimited using a carriage
return ”\r”.

Formats

Returns the list of supported DDE data formats.
Currently,
only the Text format is supported.
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Profiles

Returns a list of profiles defined in the Distinct
IntelliTerm
configuration file. Each item is delimited using a
carriage return ”\r”.

Getting Information Using the Request Message
The Request message is used to get information back from the DDE server,
Distinct IntelliTerm. It allows you to retrieve information such as the screen
format, cursor position, and the presentation space. Requests are only used to get
information back. They do not perform any actions on the emulator or system.
Examples
The following function will request the 3rd line of data from the presentation
space. The variable ChanNum represents the DDE conversation ID.
Word for Windows
Data$ = DDERequest( ChanNum, “P160L80” )
Microsoft Excel
=REQUEST( A1, “P160L80” )
REQUEST Item Names
The following is a list of available items that can be requested from a session topic.
Item Name

Description

Columns

returns the number of columns in the current
presentation
space.

Cursor

returns the current cursor location in the
presentation space. 1 is the first position.

Emulator

returns the window handle of the window displaying
the presentation space.

File Transfer

returns the short name of the presentation space and
a 0 if no transfer is occurring or 1 if a transfer is
occurring.
Example: “A 1”
Transfer occurring on session A
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Keyboard

returns the status of the 3270 keyboard. Valid return
values are: “Clear” or “Locked”.

Model

returns the 3270 model for the presentation space.
Valid values are: 2, 3, 4, or 5.

OIA

returns the Operator Information Area in ASCII
format.

Power

always returns “On”.

Profile Name

returns the name of the profile used for the
presentation space.
Example: “DEFAULT”

Rows

returns the number of rows in the current
presentation space.

Search

returns the position of the search string in the
presentation space. The search string is defined using
the POKE command.

PS

returns the entire contents of the presentation space.
The entire space is returned as one string. Nulls are
converted to blanks. Therefore, if you have a Model
2 terminal (24x80), a string of 1920 bytes will be
returned.

Pnnnn[F/Lmmm]

returns a portion of the presentation space. Nulls are
converted to blanks.
Example:
P100 returns the presentation space from position
100 to the end of the field containing position 100.
P100F returns the entire field which contains
position 100.
P100L20 returns data from position 100 for a length
of 20 characters regardless of field positions.

Fnn[U/P]

returns the contents of the field specified. Nulls are
converted to blanks.
Example:
F2 return the contents of the second field (any) in
the presentation space.
F2U returns the contents of the second unprotected
field in the presentation space.
F2P returns the contents of the second protected
field in the presentation space.
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Rnn

returns the contents of the specified row. Nulls are
converted to blanks.
Example:
R2 returns the contents of the second row in the
presentation space. The length is dependent on the
3270 model active. Models 2, 3, and 4 return 80
characters whereas a Model 5 returns 132 characters.

The following item names can be requested from the SYSTEM topic.
Item Name

Description

Formats

returns the name of the DDE formats supported.
Always returns “Text”.

Profiles

returns the list of defined profile names. Each item is
separated by a carriage return character (0x0D).

Session Started

returns the topic letter for the session last started
with the Start Session EXECUTE command.

SysItems

returns the list of system items that can be requested.
Each item is separated by a carriage return character
(0x0D).

Topics

returns the list of system topics that are currently
available for conversations. Each item is separated by
a carriage return character (0x0D).

Sending Information Using the Poke Message
The Poke message is used to send information to the DDE server, iterm. It allows
you to send information such as the screen data, new cursor position, press keys,
and set the search string. Poke does not return any information.
Examples
The following function will set the cursor position to position 1761. The variable
ChanNum represents the DDE conversation ID.
Visual Basic for Applications
DDEPoke ChanNum, “Cursor”, “1761”
Microsoft Excel 4.0
=POKE( A1, “Cursor”, B1 )
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Microsoft Excel 5.0 and 7.0
You can only poke data that exists in a cell. If you want to Poke data in a text
string, then you must use the v4.0 macros. Otherwise, use the format below and
replace A1 with the cell number that contains the text you want to poke.
DDEPoke ChanNum, “Cursor”, Range(“A1")

POKE Item Names
The following is a list of available items that can be sent to a session topic.
Item Name

Description

Cursor

sets the cursor position to the new value in the
presentation space. The syntax for the value field
is:nnn sets the position to the numeric value
specified. Fnn[U/P] sets the position to the first
position of the specified field.
Example:
1 sets the cursor to position 1.
F2 sets the cursor to the first position of the second
field in the presentation space.
F2U sets the cursor to the first position of the second
unprotected field in the presentation space.
F2P sets the cursor to the first position of the second
protected field in the presentation space.

Keystroke

presses a collection of keystrokes. The string may
contain up to 255 characters. The string format for
keys is in HLLAPI mnemonic format. Therefore,
you can enter normal text and also press 3270 action
keys such as Home, Pfx, Clear...
Example:
“LOGIN PIERRE@E”

PS

inserts the string into the entire presentation space.
In this mode, data over protected fields is ignored.
Therefore, you can retrieve the entire PS, update
certain portions, and then replace the entire PS.

Pnnnn[F/Lmmm]

inserts the string into a specific position in the
presentation space. Data insertion stops at the end of
the field or end of the data string whichever comes
first.
Example:
P100 inserts the string at position 100 until the end
of field.
B-7

Distinct IntelliTerm
P100F inserts the string in the field which contains
position 100.
P100L20 inserts the string at position 100 for a
maximum length of 20 characters, regardless of the
length of the string.
Fnn[U]

inserts the string into a specific field in the
presentation space. Data insertion stops at the end of
the field or end of the data string whichever comes
first.
Example:
F2 inserts the string starting in the first position of
the second field.
F2U inserts the string starting in the first position of
the second unprotected field.

Rxx

inserts the string into the specified row in the
presentation space. Data is only written into
unprotected fields. Example:
R2 inserts the string into the second row of the
presentation space.

Search

sets the search string for the Search request
command.

Running Commands Using the Execute Message
The Execute message is used to instruct Distinct IntelliTerm to perform commands
such as run macros, transfer files, and various other tasks. Execute does not return
any information.
Examples
The following function will upload the file C:\TEST.TXT to TSO as file
TEST.TXT in text mode. The variable ChanNum represents the DDE
conversation ID.
Word for Windows
DDEExecute ChanNum, “send file(c:\test.txt test.txt ASCII CRLF)]”
Microsoft Excel
=EXECUTE( A1, “send file(c:\test.txt test.txt ASCII CRLF)]” )
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EXECUTE Item Names
The following is a list of available commands that can be issued to a session topic.
Command Name

Description

Allow Emulator Updates

enables Distinct IntelliTerm to update the terminal
window when information is received from the host.

Block Emulator Updates

prevents Distinct IntelliTerm from updating its
window when information is received from the host.

End Session

terminates the current terminal session. This is
identical to selecting Close Session from the File
menu in Distinct IntelliTerm.

Pause

pauses for the specified time in 1/2 second
increments. The following example pauses for 2
seconds.
[pause(4)]

Run Macro

runs the specified macro. The following example runs
the macro “dothis”.
[run macro(dothis)]

Receive File

downloads the specified file from the host system to
your PC. The command syntax for TSO and MUSIC
is:
receive file(PC filename host filename transfer
options)]
The command syntax for CMS and CICS is:
[receive file(PC filename host filename (transfer
options) )]
TSO or MUSIC Example:
[receive file(c:\junk host.junk ASCII CRLF)]
CMS Example:
[receive file(c:\junk.txt junk text ( ASCII CRLF)]
CICS Example:
[receive file(c:\junk.txt junk ( ASCII CRLF))]
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Send File

uploads the specified file to the host system from
your PC.
The command syntax for TSO and MUSIC is:
[send file(PC filename host filename transfer
options)]
The command syntax for CMS and CICS is:
[send file(PC filename host filename ( transfer
options ) )]
TSO or MUSIC Example:
[send file(c:\junk host.junk ASCII CRLF)]
CMS Example:
[send file(c:\junk.txt junk text ( ASCII CRLF)]
CICS Example:
[send file(c:\junk.txt junk ( ASCII CRLF))]

Wait Unlock

pauses for the specified time in 1/2 second
increments until the 3270 keyboard is unlocked. If
the keyboard is already unlocked, the function
returns immediately. The following example pauses
for up to 3 seconds.
[Wait Unlock(6)]

The following is a list of available commands that can be sent to the SYSTEM
topic.
Command Name

Description

Start Session

starts a new session using the specified profile and
connect options. The syntax for the option field is:
“Profile Name [,IP Host/Gateway Name [,TCP Port]
]”
The Profile Name is always required. If you don’t
have a specific profile available, use “DEFAULT”.
Examples:
“[Start Session(VMTCP)]”
“[Start Session(VMTCP,132.206.27.2)]”
“[Start Session(VMTCP,132.206.27.2,1023)]”

B-10

Dynamic Data Exchange
“[Start Session(VMSPX,MVS)]”

Monitoring Session Activity Using the ADVISE
Message
You can use the ADVISE message to receive feedback of when certain events take
place such as cursor movement or presentation space updates. These are known as
warm or hot links in the DDE terminology. This allows your application to receive
update information when a specified event takes place.
As mentioned, there are two types of advise links: warm links and hot links. A hot
link updates your client information automatically whenever changes occur in
Distinct IntelliTerm, whereas a warm link requires additional steps to update your
client information. Hot links are usually used to provide continuous up-to-date
information.
Examples
The following function will request advisement when the cursor changes position.
Word for Windows
1 Insert a field in your document by pressing the INSERT FIELD key,
Ctrl+F9.
2

Enter the DDE command below for a warm or hot link. Do not enter the
curly brackets. They are the field delimiter characters.
{ dde ITERM session name item name }
{ ddeauto ITERM session name item name }
Example:
{ dde ITERM A Cursor }

Microsoft Excel
=EXECUTE( A1, “send file(c:\test.txt test.txt ASCII CRLF)]” )

EXECUTE Item Names
The following is a list of available commands that can be issued to a session topic.
Item Name

Description

Alarm

informs you that the terminal alarm has been
sounded.
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Cursor

informs you that the cursor position has changed in
the presentation space. The new cursor position is
returned in a hot link.

File Transfer

informs you when a file transfer terminates in the
presentation space. The first string returned in the PS
shortname and then a “0” to indicate file transfer
complete.

OIA

informs you that the OIA has been changed and
returns the updated OIA string.

Power

always returns “On”.

PS

informs you when the presentation space has
changed and returns the complete PS as a string.

Example of DDE Calls
The following is an example of a login to a CMS account written in Word for
Windows VBA language.
Sub Main
ChanNum = DDEInitiate( “ITERM”, “A” )
DDEPoke ChanNum, “Keystroke”, “LOGIN PIERRE@E”
DDEExecute ChanNum, “[Wait Unlock(6)]”
DDEPoke ChanNum, “Keystroke”, “password@E”
DDETerminate ChanNum
MessageBox “Logged into CMS successful”, “Information”
End Sub

HLLAPI Keystroke Mnemonics
The following mnemonics are used by the Poke Keystroke item to press special
3270 functions keys. All special keys are available by using the command delimiter
‘@’. For example, if you wish to press the Enter key, send the string “@E”. To
send a normal ‘@’ sign, send two of them, “@@”.
Special Key Strings:
600Lx,1800Lx,2400Lx,3600Lx,4200Lx;
NtGarde;
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control port traffic 7-18

INDEX
creating folders 7-17

Options menu 7-22

deleting 7-16

ownership 7-17

Deselect All 7-12

passive 7-16

destination 7-13

passwords 7-11

Disconnect 7-12

print setup 7-17

Download 7-2, 7-13

printing 7-17

Downloading 7-12

range selection 7-15
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